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SPSS:  An Introduction 
 

Welcome to your first experience with SPSS (Statistics Package for the Social Sciences).  I hope 
you find this packet useful as you begin to navigate your way through this statistics software 
package. You will refer to these instructions throughout the semester, but I highly recommend 
hanging on to the packet for use in future classes and (if you are a Psychology or Neuroscience 
concentrator) for your Senior Project.   
 
Overview 
This section of the packet will walk you through the following steps: 

 

1.   Logging on to the Citrix server to access SPSS from on campus 
2.  Accessing SPSS via Citrix from off-campus via Cisco AnyConnect (a virtual private network, or VPN) 
3. Downloading a data file to your computer and saving it to your computer or uploading it to the SSS 

(student storage server). 
4.   Opening and saving data files in SPSS. 
5. Creating a data file in SPSS. 
 
PART 1:  Logging on to the Citrix server to access SPSS from on campus 
SPSS for Windows is available via the Citrix server on any computer on campus, Macintosh or 
Windows. You are also able to use SPSS on your own computer via the Citrix Workspace App. The 
first time you use Citrix (and at the beginning of each academic year), you’ll need to register (it’s 
free). See https://www.hamilton.edu/offices/lits/rc/using-citrix for a basic intro to Citrix, how to 
install it on your Mac or Windows machine, how to register for it, and how to open SPSS. 
 
1. I recommend using Firefox as your web browser; it works better with Citrix than Google 

Chrome does. Be sure that pop-ups are enabled. In the browser window, enter the following 
address: citrix.hamilton.edu. I recommend creating a bookmark called “Citrix” for easier 
navigation. Once you’ve registered (see above), you will be prompted to download and install 
the Citrix Workspace App. See https://www.hamilton.edu/offices/lits/rc/installing-the-citrix-
client-on-your-computer for instructions. If you have any difficulty, please let me know ASAP.   
 

2. Once the Citrix Workspace App is installed, the Citrix Metaframe window will open when you 
go to the above address, and you will be prompted for your username and password, which 
should be the same as your e-mail username and password (see Figure 1). After you type these, 
ensure the appropriate Domain is selected (“students.hamilton.edu”) and click on “Log On.”  
 

 

 
 

Figure 1 
 

 
 

 
 
 

  
 Figure 2

You should now see icons for the available software 
packages you can access through the Citrix server 
(see Figure 2). You will be using IBM SPSS 
Statistics 29. Find the correct icon and click on it. 
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3. You may be prompted to open the Citrix Workspace Launcher. After doing so you will 
see a task progress window indicating that the application is starting. After a short lag 
(this could take up to 30 seconds or more), SPSS should be up and running and you can 
create a new data file or open an existing one. See instructions below in Part 4 for 
opening data files.  

 
If you encounter difficulty installing Citrix or getting SPSS to open, please contact the LITS Help 
Desk: 315-859-4181; helpdesk@hamilton.edu; Google Hangouts @hdtier1.  
 
Also, LITS has data science tutors available if you’re not able to see me or a TA: 
https://libguides.hamilton.edu/c.php?g=132443&p=8194735.  
 
PART 2:  Accessing SPSS via Citrix from off-campus via Cisco AnyConnect (a virtual 
private network, or VPN) 
 
As of November 4, 2022, anyone accessing applications via the Citrix server from off campus 
must do so using a VPN (virtual private network). If you anticipate needing SPSS while off-
campus (e.g., while away at an athletic event or over spring break), you will need to request a 
VPN here: https://www.hamilton.edu/offices/lits/forms/vpn-request-form. Once you’ve been 
approved, you can install the VPN client (Cisco AnyConnect) by following the instructions here 
for your Mac or Windows machine: https://www.hamilton.edu/offices/lits/rc/vpn-documentation. 
Once you’ve installed Cisco AnyConnect, you simply need to open it, type 
“outside.hamilton.edu” into the box, click “Connect,” enter your password, and then authenticate 
with Duo on your phone. After that, proceed to citrix.hamilton.edu as before. 
 
PART 3: Downloading a data file from Blackboard to the desktop and uploading it to your 
SSS space 

 
For your homeworks, you will use an existing SPSS data set that can be found along with the 
homework assignments in the “Homework assignments and data sets” tab on Blackboard. SPSS 
data files are named with a .sav extension (e.g., 2018 National Survey of Health Attitudes.sav, 
GSS2021.sav). Note that you cannot simply double-click on an SPSS file to open it, because you 
are accessing SPSS via Citrix. You must be within the SPSS program in order to open files. 
Therefore, when you click on the file, you will need to save it somewhere. You have a couple of 
options here: 
 

1. Save the file to a folder for this course that you create on your laptop. Use this option if you 
plan to exclusively use your own laptop for data analysis in this course.  
 

2. Save the file to your SSS. This option is the most flexible, because you can then access it no 
matter what computer you happen to be using. The easiest way to accomplish this is to 
temporarily store the file on your local computer’s desktop and then upload it to your SSS via 
the “Files” tab on your My Hamilton page. A folder called “Citrix” is in your SSS (it gets 
created the first time you open SPSS using Citrix) and there is a subfolder named 
“Documents” within that folder. Here is where you want to store all of your data files (see 
Figures 3 and 4 below). Once you’ve saved the file to your desktop, go to My Hamilton, 
choose the “Files” tab, click on “Citrix,” then “Documents,” and then choose “Upload File” 
(directly above “Name”) to place the data file in the documents folder within the Citrix folder 
on your SSS. 
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 Figure 3 Figure 4 
 
 
PART 4: Opening and saving files in SPSS 
 
When SPSS is first opened, it will prompt you as follows: 
 
 

 
Figure 5 
 
If you are using an existing data file, select “Open another file…” at the bottom of the list in the 
“Recent Files:” box and then click “Open” at the bottom of the window (or just double-click “Open 
another file…”). A box will pop up asking you how you want to access files from this application. 
Choose “Read and Write Access” and you can click the box so you aren’t asked the question again. A 
window will open to allow you to navigate to the pre-existing data file. 
 
How to find your file: 
 
1. If you saved it to a folder on your laptop (see Figure 6):  Click the down arrow on the menu bar and navigate 

to Local Disk H. Note that Local Disk C is your hard drive and H is you, signed into your hard drive. It’s 
faster to just click H rather than having to click C, then find your username, then get to H. Once you’ve 
clicked on H, you can navigate to the folder where you stored your file (or to your desktop, if you just 
dumped it there). Click on the file and then click “open”. Your data file will open in SPSS. 
 

2. If you saved it to your SSS (see Figure 7): Click the down arrow on the menu bar and navigate to your 
username followed by (\\sss.hamilton.edu\users). (Note that for faculty it is ESS for “Employee Storage 
Space” rather than SSS.) If you click on that, you’ll then see the Citrix folder and the documents folder into 
which you saved your file earlier. Click on the file and then click “open”. Your data file will open in SPSS. 
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 Figure 6 Figure 7 
 
 
Saving files (SAVE, SAVE, SAVE!) 
Be sure to save frequently so you don’t lose your work due to unforeseen circumstances. If you make 
changes to the file, you can save an updated version of it by clicking on File in the SPSS menu bar, then 
Save As. A window similar to that shown in Figure 6 or 7 will appear.  Name your file with a 
meaningful, informative label, then click ‘Save.’  A copy of your file will be saved in the folder you 
designate (either on your hard drive or on your SSS).  
 

 
Figure 8 
 
 
File types in SPSS 
 

Note that different SPSS file types have different extensions: 
 

.sav = data file 

.spv = output file 

.sps = syntax file (written code for SPSS to execute; we won’t do much with syntax in this course, but 
you will become more familiar with it in subsequent courses. Note that any command you ask SPSS to 
run via the menus can be pasted into a syntax file and saved for later use. This is very handy when 
you’re working on an actual research project.) 
 
NOTE:  
• If you click on the folder icon in a data window, SPSS will automatically try to open data.  
• If you click on the folder icon in an output window, SPSS will automatically try to open output.  
• If you click on the folder icon in a syntax window, SPSS will automatically try to open syntax.  
• If you are in a data window and want to open either an output or syntax file, you will need to go to File, 

Open, and then choose data, output, or syntax. 
 

Remember: If you are saving the file somewhere on your 
computer, you will need to click on the down arrow (see 
Figure 8), scroll to and click on Local Disk H (if on a Mac), 
and then navigate to the folder you created for the class (or 
to your desktop, but I recommend keeping your files 
organized in a folder).   
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PART 5: Creating a data file in SPSS 
 

 
Figure 9 

 
Before you can analyze your data, you must first input them into this file. Notice that the rows are 
already numbered and the columns are labeled “var.”  At this stage, the font in the columns is grey 
because they have not been activated with data or variable names. Note that each column represents a 
variable and each row represents a participant’s data for each variable. So each row represents the scores 
from one particular participant. To enter data, you will first need to create, name, and define the 
variables.  
 
Data view vs. Variable view 
You can examine your variables/data in two different screens or “views”: data view and variable view. 
In data view, you see the basic spreadsheet depicted in Figure 9. In variable view, you can easily name 
and define your variables (see Figure 10).  
 
Helpful tips for switching back and forth between data and variable view:  
• You can toggle back and forth between data view and variable view by clicking on the appropriate tab at the 

bottom left of the screen.  
• Double-clicking on a “var” header in data view will automatically toggle you to variable view 
• Double-clicking on a number in the left-hand column in variable view will return you to data view. 
 
Creating a column for participant ID number 
I recommend that your first variable always be participant ID (an arbitrary number you assign to each 
participant for record-keeping purposes). Below is an illustration of the variable view with the first 
variable added. Notice the variable label (Participant ID Number) in the “label” column. It is important 
to get in the habit of labeling your variables. Labels help remind you what each variable is, and they also 
print out in the output so you know what you’re looking at. When working with existing data sets, 
variable labels are very important in helping you understand what each variable represents. 
 

 
Figure 10 

When you open SPSS, one of 
your choices in the “New 
Files:” box is “New Dataset” 
(see Figure 5, above). If you 
click that option, you will be 
presented with an untitled data 
file (see Figure 9). Note that 
this file looks like a standard 
spreadsheet.  
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Using the $Casenum command to automatically number cases 
In Excel, you can just start typing 1, 2, 3 in a column, then drag down and have the column auto-fill the 
rest of the numbers. Sadly, SPSS doesn’t have that functionality. But you DON’T need to type every 
number between 1 and 100 if you need to give 100 participants an ID number. Instead, use the 
$Casenum command. To create an ID number this way, go up to the Transform menu and select 
“Compute Variable”. 
 

 
Figure 11 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
Defining variables 
Let’s say your second variable is the respondent’s academic concentration. As with participant ID, you 
need to provide a variable name (a concise name, e.g., “Concentration”) and a variable label (a 
description of the variable to remind yourself of what the variable is; e.g., “participant’s academic 
concentration”). Keep in mind that SPSS won’t let you begin a variable name with a number or special 
character, such as a space.  
 
For Concentration, you’ll need to provide value labels to indicate what different levels of your variable 
mean. For example, 1 = Economics, 2 = Psychology, 3 = Mathematics, etc. To add value labels, simply 
click in the appropriate cell in the “values” column (i.e., the cell that appears in the “concentration” 
row). A lightly shaded blue box appears within the cell, and if you click on it, a dialog box appears in 
the middle of the screen (see Figure 13). Simply type the value in one box, the value label in the box 
beneath it, and click “Add.” Once you’ve added all your values and value labels, click “OK.” 
 

Next, type “ID” in the Target Variable box at the upper left. 
This will name your new variable “ID”.  
 
Select “All” from the function group at right, then select 
“$Casenum” as the function and drag it up to the Numeric 
Expression box (see Figure 12). Hit “OK”. 
 
If you go back to your data window, you’ll now have a 
column of sequential ID numbers next to whatever data you 
previously had in the file. The default is 2 decimal places, 
but you can change that to 0 (see below). You can also drag 
that column over so it becomes the first one in your file. Figure 12 
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Figure 13 
 
For some variables (e.g., age), you won’t need value labels; you’ll just enter in whatever number the 
participant reports. 
 
Determining the number of decimal places shown in the data window 
In addition to giving your variable a label and defining its values, you may find it convenient to choose 
the number of decimal places you want displayed for each variable in the data window. For instance, if 
your variable is “concentration,” and the values are 1, 2, 3, 4, etc., it might annoy you to have SPSS 
display “1.00,” “2.00,” “3.00,” etc., all the way down the column (the default is 2 decimal places). To 
change the number of decimal places displayed, simply click on the appropriate cell (e.g., the one in the 
“concentration” row and the “decimals” column). Up and down arrows appear in the right-hand part of 
the cell, and you can simply click on the down arrow until you have 0 decimal places (or you can type 
“0” directly).  
 
Repeat this process of defining and labeling for all of your variables.  NOTE: You’re not entering any of 
the participants’ data yet; you’re only getting the data file set up by creating and labeling the variables.  
 
Setting missing values 
In SPSS, if you leave a cell blank, you will simply get a period (“.”) in that cell, and it will not be 
included in any of the data analyses. In the large data sets you’ll use for some homework assignments 
(e.g., GSS data), a particular number is often used to represent missing data (e.g., 999, as  
long as 999 is not a valid value for that variable). 

In variable view, there is a 
column titled “Missing” that 
alerts you to all the missing 
values for each variable (see 
Figure 14). These values must be 
defined in the Missing column in 
order for SPSS not to use them 
when calculating statistics. 
 
 

 
 
 

Figure 14 
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Entering data 
Once you’ve defined all the variables you need, you’re ready to enter the actual data. Generally, it’s 
easiest to enter all the data from a single participant before moving on to the next participant. That is, 
work row by row. I find it easiest to use the numerical keypad on the right side of an external keyboard 
(laptops don’t have these, which is why I hate entering data from a laptop!).  
 
These days, with online surveys, it is very rare to have to enter data by hand, but you will need to do so 
for some of your homework problems. For those, given that you will have only a couple of variables, it 
will probably be easier for you to enter all of the data for one column (variable) and then enter all the 
data for the next column (variable). 
 
Just for illustrative purposes, in Figure 15 you see the first portion of a sample questionnaire data file, 
showing 12 participants and their scores on the first several variables of a questionnaire. Note that 
participant 10 has missing data for age and ethnicity. 
 

 
 

Figure 15 
 
Helpful tip: Keyboard shortcuts for toggling between open windows  
 
● Toggling between windows within the same program: On a Macintosh computer, selecting Command + ~ 

(the tilde symbol, top left of your keyboard) will toggle back and forth between open windows within the 
same program. (Sorry, Windows computers don’t have this functionality!) 
 

● Toggling between different programs: This is useful for, say, going back and forth between SPSS and 
Microsoft Word if you’re writing up your homework. Hold down Command+tab on a Mac or Alt+tab on a 
PC. 

 
Checking for errors 
This is one of the most important steps of entering and analyzing data. If you made any errors inputting 
the numbers, it could wreak havoc with your analyses and your interpretation of the data. If the errors 
are big or numerous, it could mean the difference between supporting and rejecting a hypothesis! Be 
VERY CAREFUL whenever you enter data, and always double-check everything.  
 
If you’ve conducted an online survey in Qualtrics (which you might do in a future lab class or for your 
thesis) and have exported the data from it into SPSS, you still need to double-check it for errors. For 
instance, I have sometimes discovered that a scale that was supposed to range from 1 to 6 in Qualtrics 
actually exported as bizarre numbers instead: 23, 24, 25, 26, 27, 28 instead of 1, 2, 3, 4, 5, 6. This can 
happen if you make a lot of edits to a survey question by deleting options and then adding them. You 
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can avoid this by recoding the values in Qualtrics before exporting the data, but if you don’t notice until 
later, you will need to recode them in SPSS. The important point is that you need to NOTICE the error 
in order to correct it, so examining your data is vital. 
 
Toggling back and forth between the data window and the output window 
Whenever you ask SPSS to calculate something for you, you automatically get bumped into the output 
window (“SPSS viewer”) where the output from your commands (e.g., frequency tables, descriptive 
statistics, graphs) is displayed. To get back to the data window, simply go up to the “Window” menu, 
and scroll down until you see the name of the data file (see Figure 16, below). If you want to edit a 
graph, double-click on it in the output window and you will be bumped into the “Chart Editor.” Again, 
you can return to any other window by going up to the “Window” menu.  
 

 
 
Figure 16 
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Exploring Your Data: Frequency Distributions, Graphs, Descriptive Statistics 
 
Now you’re ready to start taking a look at your data. Below are instructions for creating frequency 
distributions, grouped frequency distributions, histograms, and bar graphs, and for computing basic 
descriptive statistics (e.g., mode, median, mean, range, standard deviation).  
 
Helpful tip: Changing display preferences  
 

Display options for dialog boxes: 
The SPSS default is to display the variable labels rather than the shorter variable names in the dialog 
boxes, which can make it difficult to find variables to select for analyses. To change the default, click on 
the Edit menu, then scroll to the bottom and select Options. Under the “General” tab, select “Display 
names” under Variable Lists at the top left. Note in Figure 1 below how the variable names, rather than 
long variable labels, appear in the column.  OR: When the list of variables appears when you’re 
doing a frequencies or other command, you can just click on the variable while hitting the option 
key to switch from displaying variable labels to displaying variable names. 
 
Display options for the output window: 
Under the “Output tab” in Options, you can specify that, in your output, you would like variables shown 
as names & labels, and variable values shown as values & labels. (Do so in both the “Outline Labeling” 
section and the “Pivot Table Labeling” section on the left of the dialog box.) 
 
The “Frequencies” Command 
If you want SPSS to print you a frequency distribution, go under the “Analyze” menu, scroll down to 
“Descriptive Statistics,” and then choose “Frequencies.” You’ll get a window like the one in Figure 1.  

 

 
Figure 1 

 
 

 
 
Once you’ve selected the variables you’d like to examine, you need to decide what information you’d 
like. The default is just the frequency tables (notice the check mark in the box labeled “Display 
frequency tables”). If you don’t want frequency tables, you can click on the box to remove the 
checkmark. If you click on the “Statistics” button, you can choose which measures of central tendency 
and variability you want to use. REMEMBER: You need to figure out what level of measurement a 
particular variable represents before willy-nilly choosing statistics. For example, calculating a mean 
gender doesn’t make any sense, because gender is measured on a nominal scale. SPSS WILL DO 
WHATEVER YOU TELL IT TO DO, EVEN IF YOU TELL IT TO DO SOMETHING WRONG! So 
you have to make sure to choose your statistics wisely. 

On the left side is a list of all the variables in your data file. 
If you have set your preferences as noted above, the variable 
names (not labels) will be listed. Simply click on the 
variable you want to examine, then either click the arrow to 
pop it into the “Variable(s)” box or just drag it there. 

Helpful tip: Selecting multiple variables at a time 
• Hold down the Control key while clicking on the variable 

names with the mouse to select more than one variable at a 
time.  

• If the variables you need are listed in order in the data file, 
you may click on the first variable, hold down the Shift key 
and click on the last variable to select all of them. 
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Grouped Frequency Tables 
When you have a very large data set (and variables with many values), you can manually create grouped 
frequency tables. As an example, let’s say that I want to create a grouped frequency table for the AGE 
variable in a very large dataset. First, I need to create a “binned” (grouped) variable based on the 
original variable, and then I need to use the frequency command on that new binned variable to produce 
the grouped frequency table. 
 
To create the binned variable, go to the Transform 
menu and select “Visual Binning” (see Figure 2): 
 

 
Figure 2 Figure 3 
 
You’ll get the dialog box shown below. Next, name the new binned variable (e.g., AGE_binned). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Note that only the subset of variables in the file 
appropriate for binning are displayed (see Figure 3). 
Select the variable you want to bin and click on the arrow 
to put it into the right-hand box. Then click “Continue.” 

Next, choose “Make Cutpoints” (see 
Figure 4) to decide on the number of 
intervals and the width of each 
interval. Equal width intervals is the 
default selection. You must fill in 2 of 
the 3 fields (e.g., number of cutpoints 
and width of interval). Generally 
speaking, 10-15 intervals works well. 
 
The number of cutpoints equals the 
number of intervals minus 1. (Think 
about it: if you wanted to cut a banana 
into 3 pieces, you’d have to make 2 
cuts.) So if we wanted 10 intervals, 
we’d have 9 cutpoints. 
 
For the width of each interval, (a) find 
the difference between the maximum 
and minimum values for the variable 
(shown in the dialog box), (b) divide 
this difference by the number of 
intervals (in this example, [89 – 18]/10 
= 7.1), and (c) round up to the nearest 
whole number (8.0). Enter that number 
as interval width. 

 

 

 
 

Figure 4 
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Click in the First Cutpoint Location box, which will then fill in automatically (see Figure 5). In this 
example, “18” automatically appears in that box. Click “Apply” to return to the main Visual Binning 
dialog box. 
 

 
 Figure 5 
 
Click “Make Labels” to label each interval with the range of data it contains (see Figure 6). Note that for 
this example, the age ranges are a little strange. It’s more common to have age ranges of 10 years per 
interval. If you wanted to bin the data that way, you could have chosen to make 8 groups of 10 rather 
than 10 groups of 8 by selecting 10 as the interval width and 7 as the number of cutpoints. Once you 
have made your labels, click OK and then OK again to create the new binned variable, which you can 
see has been added as the last variable in your dataset. 
 

 
Figure 6 
 
Now you can create the frequency distribution using the new binned variable by going to Analyze—
Descriptive Statistics—Frequencies and selecting “AGE_binned” as the variable. You will get the 
output below: 
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Histograms & Bar Graphs 
If you want to look at your data graphically, you might choose to have SPSS draw you a histogram or a 
bar graph of a particular variable. Remember, histograms are used for variables that are continuous in 
nature (e.g., height), whereas bar graphs are used for discrete or categorical data (e.g., marital status). 
Simply click on the “Charts” button within the frequencies dialog box (see Figure 1) and choose which 
type of graph you want.  
 
The “Descriptives” Command 
Another way to get basic descriptive statistics is to go under “Analyze,” “Descriptive Statistics,” 
“Descriptives.” Here you’ll get many of the same options as with the “Frequencies” command, only you 
won’t get a frequency table (you also can’t get the median or mode). Use this command if you just want 
to get a quick mean and standard deviation (or standard error) for a bunch of variables at once. 
 
 
Play around! Explore! Have fun! 
SPSS is a fairly user-friendly program. If you get lost, simply scroll around in the menus until you find 
what you’re looking for. If you’re really lost, you can probably Google for help.  Remember, though: 
SPSS will blindly do whatever you tell it to do, regardless of whether or not it’s a sensible command. So 
be smart about what you tell it to do. Now you’re ready to explore your data. Enjoy!  
 
 

Voìla!  
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Annotating and Printing Output for Your Homework Assignments 
 
Unfortunately, SPSS output is not printer-friendly. Printing output “as is” wastes a lot of trees. You can 
certainly save your output (.spv) files on your computer to look at on your screen, but note that in order 
to view those files, you’ll need to be in SPSS. Here’s what I recommend whenever you need to print 
output for assignments: 
 
Take a screen grab of the relevant parts of the output (On a Mac: Ctrl+Command+Shift+4; for PCs, 
use the snipping tool) and paste them (Command+v) into a Microsoft Word or Google doc. You can 
then re-size the images to make them smaller to fit on your page (be sure to grab each one from the 
corner and drag so it adjusts height and width proportionally). 
 
Many of the homework assignments require you to annotate (i.e., label and explain) your SPSS output. I 
recommend that you do so in one of three ways: 
 
1. If you do your homework using Microsoft Word or Google docs: Print the relevant parts of the SPSS 

output that you’ve inserted into a Word or Google doc, write on the output in pen, take a clear photo 
of the annotated output with your phone, and insert the photo into the Microsoft Word or Google doc 
containing the rest of your homework. Save the Word doc as a pdf or download and save the Google 
doc as a pdf and upload to Gradescope. 
 

2. If you do your homework by hand (pen and paper): Print the relevant parts of the SPSS output that 
you’ve inserted into a Word or Google doc, write on it in pen, and scan it with a phone scanning app 
(e.g., SwiftScan or Scanner Pro for iOS; Genius Scan or Mobile Doc Scanner for Android) as one of 
the pages of your homework; it will become part of the single pdf that you’ll upload to Gradescope. 
If you use this option, remember that all APA-style Results sections must be typed, so you’ll need to 
print that and scan it with the rest of your handwritten homework. 
 

3. If you regularly use an iPad or other tablet to do your homework, you can use your favorite note-
taking app to annotate output. Take screen grabs of the relevant portions of the output, insert them 
into your notes, and use the drawing tools to annotate them. If you do your homework by hand on 
the app (but type the APA-style Results section), save the whole thing as a pdf and upload to 
Gradescope. 

 
 
If you can’t get the screen grab to work, you can export your output as “rich text format,” which will 
open in Microsoft Word, but this is fairly cumbersome and uses more trees than necessary. From within 

the output window, go to the “File” menu and choose “Export.” 
You will see the window shown in Figure 1. Choose 
“Word/RTF(*.doc)” as the type (it’s the default), click “browse” 
to decide where to save the file, give the file a descriptive name, 
and click OK in the Export window. You can now open the 
saved file in Microsoft Word, reformat the tables if you wish, 
and delete any unnecessary information.  
 
 
 
 

 

Figure 1 
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If you choose to export your output this way, you should print four pages to a sheet to save paper. To do 
so on a Macintosh, select “Print” from the “File menu.” Under the “Copies & Pages” pull-down menu, 
change the setting to “Layout,” and change “Pages per sheet” to 4 (see Figure 2): 

 
 
 
 
 
 
 
 
  
  
  

Figure 2 
 
 
 

Ending your Citrix Session 
 

When you are done working, remember to save your files. Then, from within SPSS, choose File, then 
Exit. This will automatically log you off of Citrix as well.  
 
If you forget to do this and instead quit Citrix without first quitting SPSS, it is very important to select 
log off rather than disconnect so you don’t have multiple Citrix sessions open.
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Basic Data Manipulations: Recoding Variables and Computing New Variables 
 
Recoding Variables 
Sometimes it’s useful to be able to combine existing categories of responses into broader categories. For 
example, in the 2018 General Social Survey, the income variable had very narrow categories (1 = under 
$1,000; 2 = $1,000-$2,999; 3 = $3,000-$3,999; 4 = $4,000 – 4,999, etc…through 26 = $170,000 or 
over). Perhaps you don’t need 26 different income categories, but would rather group them into more 
meaningful chunks. You could decide that you want the following categories instead: 
 
1 = under $20,000  (this would encompass values 1 – 12 in the old variable) 
2 = between $20,000 and $40,000   (values 13 – 17 in the old variable) 
3 = between $40,000 and $60,000  (values 18 – 19 in the old variable) 
4 = between $60,000 and $90,000  (values 20 – 21 in the old variable; note that there’s unfortunately not an even 
break at $80,000 in the data set) 
5 = between $90,000 and $130,000 (values 22 – 23 in the old variable) 
6 = over $130,000 (values 24 – 26 in the old variable) 
 
To do this, you would need to recode the original values into new ones. The original values 1-12 would 
be recoded as a 1 (under $20,000) in the new variable. The original 13-17 would become 2, and so on. 
To accomplish this in SPSS, go to the Transform menu and scroll down to Recode (see Figure 1).  
 

 
Figure 1 
 
 

 

 
Figure 2 

You get two options: “Recode into same 
variables” and “Recode into different variables.” 
The former changes the existing variable and the 
latter creates a new variable with the recoded 
values. I recommend always creating a new 
(different) variable and leaving the original 
intact. If you choose “Into different variables,” 
you will get the window you see in Figure 2, 
below. 

The names of all your variables will appear in the list 
on the left part of the window. Scroll down until you 
find the variable(s) you’re looking for. In this case, I 
want to recode the INCOME variable. Simply click 
on the variable you want, then click on the arrow 
(which will be pointing the opposite of the way it’s 
pointing in the figure). Now you need to tell SPSS 
what you want the new (recoded) variables to be 
called. To make life easier, I usually just add “r” to 
the original variable name, to remind myself that the 
variable has been recoded. In this case, income 
becomes income_r. Type this new name in the 
“output variable” box on the right of the window and 
click on the “Change” button. 
 



19 
 

 

Now you’re ready to tell SPSS how to recode the variable. To do so, first click on the “Old and New 
Values” box. You’ll get the screen you see below. In this case, we want the first 12 income categories of 
the old variable to become a “1” in the new, recoded variable. Notice that in the dialog box below, I’ve 
defined a range from 1-12 for “Old Value”. On the right, I’ve entered a 1 under “New Value”. You 
would then click on “Add,” and keep going with the rest of the recodes (e.g., 13-17 becomes a 2, 18-19 
becomes a 3, etc.). When you’ve added all the recodes to the Old®New box, click Continue.   
 

  
Figure 3 
 
Recoding is useful in other instances as well. For instance, questionnaires are often constructed such that 
approximately half of the questions are framed positively and the other half are framed negatively. For 
example, the 2016 General Social Survey included 6 items from the Life Orientation Test – Revised, a 
measure of optimism (see below). These items are scored on a 5-point Likert-type scale, from 1 
(strongly disagree) to 5 (strongly agree). Note that items 2, 4, and 5 are reverse-worded, such that high 
numbers actually mean greater pessimism rather than greater optimism. Researchers generally want to 
combine items such as these into a single measure for analysis (i.e., a single optimism score that 
represents the mean of each respondent’s rating for all six questions). To do so, we would first have to 
reverse-score the three reverse-worded items, so that higher numbers always mean higher optimism.  
 

 
Figure 4 
 
We could do this in a similar way to how we recoded the income variable, above. To reverse the 
response scale for items LOTR2, LOTR4, and LOTR5, we need to recode the values such that 1=5, 2=4, 
3=3, 4=2, and 5=1. Since both variables are being recoded in the same way, we can put both of them in 
the box shown in Figure 2. When we click “Old and New Values,” we’ll get the following: 
 

This will take you back to the window in 
Figure 2, and you can simply click “OK.” 
If you now scroll to the end of your data 
file, you’ll find a new column there called 
income_r. You can run a frequency on it 
(Analyze, Descriptive Statistics, 
Frequencies) to double-check that your 
categories look good. 
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Figure 5 
 
Computing a new variable from existing ones 
Once you have recoded any reverse-worded items, you can compute what is known as a “composite 
variable” for the questionnaire. That is, you will compute a variable that represents each participant’s 
mean of all the questionnaire items. (Note: Technically you would only do this if you had ascertained 
that all of the variables were highly intercorrelated with one another, but that’s a lesson for another 
course! Given that this is an established optimism scale, we’ll go ahead and compute the mean.) 
 
There are 6 items on the optimism scale, so if I wanted to compute each participant’s mean optimism 
score based on those 6 items, I could use a compute statement. Don’t forget that we need to use the 
recoded items instead of the originals for questions 2, 4, and 5. To create our compute statement, we 
would go up to the Transform menu again and scroll down to “Compute.” You should then see a 
window that looks like the one below: 
 

 
Figure 6 
 
 
NOTE: You can use the compute command to perform any of a number of functions. I’ve chosen to 
calculate a mean. 
 
 
Helpful tip: Pasting syntax 
 

If you wanted to save this compute formula to use again later, you could click “Paste,” and the formula 
would get pasted into the Syntax window, where you could run the command by highlighting it and 
clicking the green “go” button, and could also save it for later use. 

Note that this time we’re recoding individual 
values rather than a range. Note how I’ve already 
recoded 1 into 5, 2 into 4, 3 into 3, and 4 into 2, 
and am in the process of changing 5 into 1. 

Note how I’ve typed “LOTR_mean” in the “Target 
Variable” box. That means I want SPSS to create a 
new column labeled “LOTR_mean” that will 
represent each participant’s mean on the optimism 
scale. In the “Numeric Expression” box, I’ve 
indicated that I want this new variable to equal the 
mean of the items on the optimism scale, 
substituting the recoded items for the originals 
where appropriate. When you’re all set, click “OK.” 
If you scroll to the end of the data file, you’ll see a 
new column labeled “LOTR_mean.”  This variable 
would represent each participant’s average 
optimism score based on the 6-item questionnaire. 
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SPSS Instructions for a One-Sample t Test 
 
Let’s use data from a previous semester of Psych Stats to illustrate how to conduct a one-sample t test. 
We will examine the number of hours of sleep per weekday that students get, and whether this number 
differs significantly from the recommended 8 hours. The first several cases of the file appear as follows: 
 

 
Figure 1 
 
 

  
Figure 2 
 
 
 

 
 

To conduct a one-sample t test in SPSS, go to the 
“Analyze” menu and click on “Compare means” 
and then “One-Sample T Test.” Click on the DV 
you want to analyze (in this case, 
“sleep_wkday”) and click on the arrow to put it 
in the “Test Variable(s)” box (see Figure 2). 
 

Next, you need to decide what your test value is 
going to be. This is the value to which you will 
compare the overall mean of the distribution. For 
our example, the test value is 8 hours, as we want 
to know whether the mean number of hours of 
sleep in our sample differs from 8. Type “8” in the 
“Test Value” box (see Figure 2).  You will get the 
output shown below: 
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The top box gives you the overall M and SD of the distribution. Here, we see that students in this sample 
get an average of 7.35 hours of sleep per weeknight. Is this number significantly different from the 
recommended 8 hours of sleep? To find out, look in the second box. You will find the t value (-7.02; 
notice that it is negative because it is less than the test value of 8. Round to make it an even number), the 
df (N – 1), and the significance value (use “Two-Sided p” for a two-tailed test). The p value is less than 
.05 (p < .001), so students in this sample get significantly less than 8 hours or sleep per weeknight.  
 
The 95% confidence interval of the difference is also shown; this interval represents the interval within 
which we are 95% certain the true difference between our observed mean of 7.35 and the population 
mean of 8 lies. This interval does not contain 0, so we are 95% confident that our observed mean does 
indeed differ from the test value of 8.  
  
When doing CIs by hand for the one-sample t test, you typically build them around the observed mean, 
not the difference. To compute the 95% confidence interval around the observed mean based on the 
SPSS output, simply add μ (the test value or population mean specified under the null hypothesis; 8 in 
this case) to the lower and upper confidence limits. So we would be 95% certain that the true value of 
the population mean falls between 7.16 and 7.53, an interval that does NOT contain our test value of 8 
hours. 
 
SPSS provides Cohen’s d by default; it’s shown in the bottom box under “Point Estimate”.   
 

 
Sample APA-Style Results Section: 
 

A one-sample t test was conducted to determine whether Hamilton students get more or less than 

the recommended 8 hours of sleep per night during the week. The mean number of hours of sleep per 

weeknight reported by the sample (M = 7.35, SD = 1.02) was statistically significantly lower than 8 

hours, t(120) = -7.02, p < .001, d = -0.64; 95% CI [7.16, 7.53].  

 
Important details for writing a Results section involving a one-sample t test:  

● Italicize M, SD, t, p, and d. 
● Report p to 3 decimal places. Always provide the exact p value (e.g., p = .004) unless p < .001, in which 

case you simply write p < .001.  
● When p > .05, report that the difference was NONsignificant, not INsignificant. Report the exact p value 

even if the test is not significant. 
● Round everything to 2 decimal places, except the p value, for which 3 decimal places should be reported.  
● Use a leading zero for numbers less than one that can take on values less than or greater than 1 (or -1). 

Notice that I used a leading zero for Cohen’s d (-0.64, not -.64). 
● Be sure to state whether the observed mean was higher or lower than the test value for any significant test. 
● Don’t forget to report Cohen’s d and the 95% confidence interval. 
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Sample SPSS Annotation 
 
When you are asked to annotate your SPSS output for your homework assignments, you should do so in 
a manner similar to the example shown below. 
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SPSS Instructions for Independent-Samples (a.k.a. “Independent-Groups”) t Test 
 

Let’s use data from the 2018 General Social Survey to illustrate how to conduct an independent-samples 
t test. We will examine whether respondents who feel discriminated against on the basis of gender 
(variable = WKSEXISM, 1 = yes, feels discriminated against and 2 = no, does not) report being 
unhappy or depressed more often (variable = UNHAPPY, ranging from 1 = never to 5 = very often 
unhappy or depressed in past 4 weeks).  
 
To conduct an independent-samples t test, open the data file, go to the “Analyze” menu, and click on 
“Compare means” and then “Independent-Samples T Test.” Click on the DV you want to analyze (in 
this case, “UNHAPPY”) and click on the arrow to put it in the “Test Variable(s)” box. Click on your IV 
(WKSEXISM) and put it in the “Grouping Variable” box (see Figure 1). 
   

  
Figure 1 Figure 2 
 
Notice the question marks next to WKSEXISM in the Grouping Variable box. Click on “Define 
Groups” and the box shown in Figure 2 will open where you can tell SPSS what numbers are used to 
represent each of the two groups (e.g., 1 = yes, 2 = no). Once you’ve done so, click “Continue” and then 
“OK.” SPSS will bump you to the Output window where you can examine the results of the t test. 
 

 

Notice that SPSS computes the mean and SD 
of the DV (UNHAPPY) for each level of your 
IV (WKSEXISM). 

Use the point estimate for Cohen’s d. Here, 
Cohen’s d = 0.57. 
 
To get the eta-squared, you will need to 
compute it by hand using the formula t2 
divided by t2  + df. Be sure to use 3 decimal 
places for t in your computation. 
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Before you examine the results of the actual t test, you should check the results for Levene’s Test for 
Equality of Variances, which assesses whether the variances of the two groups are significantly 
different from each other (i.e., whether the homogeneity of variance assumption has been violated). If 
the p value for the Levene’s test (in the “Sig.” column) is greater than .05, then the variances are not 
significantly different from one another (i.e., the homogeneity of variance assumption has been 
satisfied), and you may use the t value, degrees of freedom, and p value in the row marked “equal 
variances assumed.” If the significance value for Levene’s Test is less than .05, you will instead need to 
use the values reported in the row labeled “equal variances not assumed.” Even if Levene’s Test is 
significant, it is acceptable to use the df from the “equal variances assumed” row. 
 
In the output shown here, the variances do not differ significantly (p = .135), so we can examine the t 
test results from the row labeled “equal variances assumed.” We see that the observed t is 3.73. Note 
that SPSS provides both a one- and a two-tailed (“two-sided”) p value. You will always report the two-
sided p. Because p < .05, this test is statistically significant. We’ll now look at the means to determine 
which group had the higher mean. It looks like respondents who reported feeling discriminated against 
on the basis of gender were unhappy more often (M = 2.52, SD = 1.07) than were respondents who did 
NOT feel discriminated against (M = 1.96, SD = 0.98). The 95% CI is built around the difference 
between the two means. The CI does not include zero (which would be the expected difference if the 
null hypothesis were true). 
 
When writing up the results, be sure to include the t (rounded to two decimal places), df, p value, the M 
and SD for each group, the strength of the relationship (effect size measures), and the 95% CI. 
 
Sample APA-Style Results Section for an Independent Samples t Test: 
 

An independent-samples t test compared whether respondents who do and do not feel 

discriminated against on the basis of gender differed in how often they reported feeling unhappy over 

the previous four weeks. The test was statistically significant, t(695) = 3.73, p < .001, d = 0.57, η2 = .72, 

indicating that respondents who reported feeling discriminated against on the basis of gender were 

unhappy more often (M = 2.52, SD = 1.07) than were respondents who did not (M = 1.96, SD = 0.98); 

95% CI [0.27, 0.86].  

Important details for writing a Results section involving an independent-groups t test:  
● Italicize M, SD, t, p, and d. 
● Round M, SD, t, and d to 2 decimal places.  
● Report p to 3 decimal places. Always provide the exact p value (e.g., p = .004) unless p < .001, in which 

case you simply write p < .001. Make sure you’re reporting the two-sided p (non-directional test). 
● When p > .05, report that the difference was NONsignificant, not INsignificant. Report the exact p value 

even if the test is not significant. 
● Use a leading zero for numbers less than one that can take on values less than or greater than 1 (or -1). 

Notice that I used leading zeroes for one of the SDs, Cohen’s d, and the CI values. 
● Be sure to state the nature of any significant effect (which mean is higher). 
● Don’t forget to report estimated Cohen’s d and η2 (effect size) for any significant effect. To type the “eta” 

symbol, type the lower-case letter “h” and change it to Symbol font. Use 3 decimal places for t to 
compute η2. 

● State the 95% confidence interval. 
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SPSS Instructions for a One-way ANOVA 
 

Imagine we want to know whether providing a jury with information about a defendant’s prior criminal 
record influences the extent to which they believe the defendant is guilty. Participants heard a recording 
of a case about a woman accused of writing bad checks, and were randomly assigned to one of three 
groups: Group 1 was told she had previously bounced checks (i.e., she had a criminal record); Group 2 
was told that this was her first offense (i.e., she had a clean record); and Group 3 was given no 
information (control). The DV was a 1-10 rating of how guilty participants thought the defendant was. 
Because the DV is at least interval and the IV is between-subjects with more than 2 groups, a one-way 
ANOVA is appropriate. 
 
To run a one-way ANOVA in SPSS, go under the “Analyze” menu to “Compare means” to “One-way 
ANOVA…” You will get the following window: 
 

 
Figure 1 

 
Click the box labeled “Estimate effect size for overall tests” to get the eta-squared. 
 
Now you need to tell SPSS which post-hoc multiple comparison procedure(s) you want to use (to 
compare pairs of means if the overall F is significant). Click on the box labeled “Post Hoc.” SPSS will 
open the window in Figure 2 below. You are given the option to choose among various post-hoc tests. 
Tukey’s HSD is the most widely-used procedure, so go ahead and click on the box next to “Tukey” 
(NOT “Tukey-b”). Click “Continue” to get back to the ANOVA window.  
 

    
Figure 2          
 
 

Click on the variable you want to use as your 
IV (“condition” in the above example) and 
move it to the “Factor” box by clicking on the 
appropriate arrow. Next, click on the variable 
you want to use as your DV (“guilt”) and put it 
in the box labeled “Dependent List.” If you 
wanted, you could put a whole bunch of DVs 
in the box at the same time, and SPSS would 
run a separate ANOVA for each DV. 
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 Figure 3 
 
The first part of your output provides the Ms and SDs for each condition. Note also that you are given 
the standard errors for each condition, which are equal to the SD divided by the square root of n (in this 
case, 5). The confidence intervals here are around each mean, NOT around the difference between 
means (those are in a later piece of the output). 
 

 
 
Next, you get your basic ANOVA source table, as shown below. You would write F(2, 12) = 4.06, p = 
.045.  

 
 
You are also given a table of effect sizes that contains the η2 (see below; it’s the value listed in the first 
row under “Point Estimate”: η2 =.40). You would report η2 if the F is significant, as it is here. 
 

 
 

Next, you want to make sure that you get descriptive 
information printed out (means and standard deviations for 
each condition), as well as the labels of each condition. To 
do that, from the “One-way ANOVA” window, click on 
“Options.” When the window comes up, click in the box 
labeled “Descriptive” (See Figure 3, right) and then click 
“Continue.” When you get back to the main ANOVA 
window, click “OK”. Examine your output.  
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Given that the overall F is significant, you would go ahead and examine the post-hoc test output to 
determine which means are significantly different from one another. SPSS provides this information two 
different ways; the first appears below: 
 

 
 
In the above output, you can examine the size and significance of the three pairwise comparisons: 
 
Criminal vs. clean (p = .044) 
Criminal vs. no info (p = .142) 
Clean vs. no info (p = .777) 
 
Note that the same information is provided twice (e.g., criminal vs. clean, then clean vs. criminal), so 
you can ignore the duplicates. You can also use this table to find the 95% confidence interval around the 
difference between each pair of means (e.g., the 95% CI around the difference between criminal and 
clean is 0.10 – 7.90). 
 
SPSS also provides another way of examining the differences between means: 
 

 
 
Means in different subsets differ at p < .05, whereas means in the same subset do not. In the table above, 
clean record (M = 4.00) is in Subset 1 and criminal record (M = 8.00) is in Subset 2, so we know that 
they significantly differ. However, no information (M = 5.00) is in Subsets 1 AND 2, which means that 
it does not differ from either clean or criminal record. I find this way of interpreting the differences 
easier in terms of explaining the overall pattern of results in the simplest way. 
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Sample APA-Style Results Section: 
 

A one-way ANOVA on guilt ratings as a function of prior information about a defendant was 

statistically significant, F(2, 12) = 4.06, p = .045, η2 = .40. A Tukey HSD test indicated that mean guilt 

ratings were significantly higher for participants told a defendant had a prior criminal record (M = 8.00, 

SD = 2.12) than for those told she had a clean record (M = 4.00, SD = 2.24), p = .044; 95% CI [0.10, 

7.90]. Guilt ratings for those not given information about a prior criminal record (M = 5.00, SD = 2.55) 

did not differ from ratings in either the criminal record condition, p = .142; 95% CI [-0.90, 6.90] or the 

clean record condition; p = .777; 95% CI [-4.90, 2.90]. 

 
Important details for writing a Results section involving a one-way ANOVA:  

● Italicize M, SD, F, and p.   
● Don’t forget to write the degrees of freedom, between and within, in parentheses.  
● Round M, SD, and F to 2 decimal places. 
● Report p to 3 decimal places. Always provide the exact p value (e.g., p = .004) unless p < .001, in which 

case you simply write p < .001.  
● When p > .05, report that the F value was NONsignificant, not INsignificant. Report the exact p value 

even if the test is not significant. 
● Use a leading zero for numbers less than one that can take on values less than or greater than 1 (or -1). 

Notice that I used leading zeroes for some of the values in the CIs. Note that η2 does NOT get a leading 
zero because its maximum value is 1. 

● First, indicate whether the overall F was significant. If so, report the value of η2 and discuss the results of 
the post hoc test (be sure to state which post hoc test you used). In describing the pattern of results, be 
sure to state the Ms and SDs of each group in parentheses, and don’t forget to report the 95% confidence 
intervals for the differences between group means. 

● There is no need to provide the M and SD for the same group twice (i.e., if you are comparing that group 
to two different groups, you only need to provide the descriptive statistics the first time you mention that 
group).
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SPSS Instructions for a Paired Samples (a.k.a. “Correlated Groups”) t Test 
 
Imagine that a researcher was interested in the effect of sleep deprivation on motor skills performance. 
Twelve participants were tested on a motor-skills task after 24 hours of sleep deprivation and again after 
48 hours. The DV is the number of errors made on the motor skills task. The data for this example 
appear below.  
 

 
Figure 1 
 
To conduct a paired samples t tests in SPSS, go under the “Analyze” menu to “Compare Means” to 
“Paired-Samples T Test.” You will get the following window:   
 

 
Figure 2 
 
Descriptive statistics for the two levels of your IV (# of errors as a function of condition): 
 

 
 
Ignore the next table.  It represents the correlation (r) between the two variables. 
 

 

Note how these data are entered differently from the way data are 
entered for an independent-groups t test. In the repeated-measures 
case, each level of the IV is represented as a separate column. 
 

Choose which variables to compare by 
clicking on them and putting them in the 
“Paired Variables” box. If you shift+click on 
both, you can add them both at once. Then 
click “OK” and you will get bumped to the 
output window where you can examine your 
findings (see below). 
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This table provides you with the difference between the two means (-1.17), the observed t, df, p-value 
(use the “two-sided” p), and 95% CI. 

 
 
We see that the observed t, with 11 df, is -2.65, and the (two-sided) p value is .023, which is less than 
.05, so the difference between the two means is statistically significant. Looking at the means in the first 
table, we can see that people made significantly more errors on the motor skills test following 48 hours 
of sleep deprivation than following 24 hours.  
 
Because the test was statistically significant, we should also report the strength (effect size). SPSS gives 
us Cohen’s d (see below; use the Point Estimate), but not η2, so you’ll need to conduct that one by hand 
with the formula t2 divided by t2  + df.  
 

 
 
 
Sample APA-Style Results Section: 
 

A paired-samples t test comparing the average number of errors participants made on a motor 

skills task after 24 and 48 hours of sleep deprivation was significant, t(11) = -2.65, p = .023, d = -0.76, 

η2 = .79. Participants made significantly more errors after 48 hours of sleep deprivation (M = 2.58, SD = 

1.31) than after 24 hours (M = 1.42, SD = 1.00); 95% CI [-2.14, -0.20].  

 
Important details for writing a Results section involving a paired-samples t test:  

● Italicize M, SD, t, p, and d. 
● Round M, SD, t, and d to 2 decimal places.  
● Report p to 3 decimal places. Always provide the exact p value (e.g., p = .004) unless p < .001, in which 

case you simply write p < .001. Make sure you’re reporting the two-sided p (non-directional test). 
● When p > .05, report that the difference was NONsignificant, not INsignificant. Report the exact p value 

even if the test is not significant. 
● Be sure to state the nature of any significant effect (which mean was higher). 
● Be sure to report estimated Cohen’s d and η2 (strength of the effect) for any significant effect. 
● Don’t forget to report the 95% confidence interval for the mean difference. 
● Use a leading zero for numbers less than one that can take on values less than or greater than 1 (or -1). 

Notice that I used leading zeroes for Cohen’s d, and one of the CI values. 
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SPSS Instructions for a Repeated-Measures ANOVA 
 
A researcher was interested in the effect of presentation modality on word recall. Words were presented 
to participants in all three of the following modalities: visual only, auditory only, both visual and 
auditory. The DV was the number of words recalled in each modality. 
  
The data for this example appear below. Note how these data are entered differently from the way data 
are entered for a one-way between-subjects ANOVA. In the repeated-measures case, each level of the 
IV is represented as a separate column.  
 

 
 
   

     
    

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Run a one-way repeated-measures ANOVA in SPSS by 
going under the “Analyze” menu to “General Linear 
Model” then “Repeated Measures…” You will get the first 
window shown below, left. 
 
Because your DV cannot be found in a single column, but 
rather is distributed across three columns, you need to 
specify a name for the within-subjects variable to tell SPSS 
where to find the data. In the middle window below, I have 
named this factor “modality” and noted that it has 3 levels.  
Next, I clicked on “Add” (see window below, right).  
 

Next, select “Define” to define your within-
subjects variable and you will see the window to 
the right. Simply click on the name of the level of 
the IV in the left column, then click on the arrow, 
and it will move into the right-hand box. Do this 
for all three levels of the IV (notice in the window 
that I have done it only for the first one so far). If 
you click on the first one, then shift+click on the 
last one, you can select all three at once. 
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Next, click on “Options,” then click on Descriptive statistics (to get means and SDs for each condition) 
and Estimates of effect size (to get partial η2); see below left. Then click “Continue”.  
 
When you’re back in the main dialog box, select “EM Means” to get the dialog box shown below, right. 
Here is where you will ask SPSS to conduct the post-hoc comparison of means. Select the factor 
(modality) and drag it to the “Display Means for” box (or click on the arrow to pop it in the box). Select 
“Compare main effects” and choose “Bonferroni” from the drop-down menu. Click “Continue”. 
 

  
 
 
 
 
 
 
 
 
 
 

 
 
 

 
Now click on “OK” in the Repeated Measures box and you’ll get bumped to the output window, where 
you can examine your findings. SPSS produces a lot of output for the repeated-measures ANOVA, and 
you can ignore much of it. Note that you will be using the F value from the “Tests of Within-Subjects 
Effects” box (NOT the “Multivariate Tests” box).  
 
As always, you get Ms and SDs for each condition. Note that, because this was a within-subjects design, 
the total sample size is 13 (i.e., the same 13 people were in each condition). Also note that the SD for the 
“both” condition would be rounded to 2.04 (it ends in exactly 5, so you would round to make it an even 
number). 
 

 
 
You can ignore the following table: 
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Next, examine the results of the Mauchly test (see below), which tests for violations of the sphericity assumption. 
If Mauchly’s test is significant (p-value in the Sig. column is less than .05), then the sphericity assumption has 
been violated. [In other words, the variance of difference scores isn’t the same for all pairwise sets of difference 
scores; at least one variance significantly differs from another.] 
 

 
 
We can see here that Mauchly’s test produced p = .007, which is significant (less than .05), indicating a violation 
of sphericity.   
 
Unfortunately, the Mauchly test under-detects violations of sphericity in small samples (for example, on 
homework problems) and over-detects violations of sphericity in large samples (for example, in the GSS data set). 
So researchers recommend always assuming sphericity has been violated and using a correction factor. 
SPSS provides three:  

 
• Greenhouse-Geisser epsilon (e)  
• Huynh-Feldt epsilon (e)  
• Lower-bound epsilon (e)  — we won’t use this one (it is too conservative) 

 
The Greenhouse-Geisser and Huynh-Feldt (pronounced HWIN FELT) estimates both range from the lower-bound 
estimate of sphericity (most severe departure from sphericity) to 1 (no departure from sphericity). The lower-
bound for both the Greenhouse-Geisser and Huynh-Feldt epsilons is 1/(k – 1), where k = # of conditions. So, for 3 
conditions, the Greenhouse-Geisser and Huynh-Feldt epsilons would range from .50 to 1. Notice that SPSS 
provides the lower-bound epsilon of .50. This correction is considered too conservative (i.e., results in more Type 
II errors) and so is not preferred. Also notice that, as k increases, the lower bound decreases, resulting in an 
increased potential for severe sphericity violations. 
 
When the Greenhouse-Geisser e is greater than 0.75, the correction is too conservative, but the Huynh-Feldt 
epsilon tends to overestimate sphericity. So use this rule of thumb: 
 

• when the Greenhouse-Geisser e ≥ .75, use the Huynh-Feldt correction 
• when the Greenhouse-Geisser e < .75, use the Greenhouse-Geisser correction 

 
In this case, Greenhouse-Geisser e = .63, so we will go ahead and use it. The correction is made by multiplying 
dfB and dferror by the appropriate epsilon to obtain new df. If sphericity hasn’t been violated, the epsilons are close 
to 1 and won’t affect the df that much. (This is why it’s fine to always apply the correction.) 
 
Recall that the shape of the F distribution is determined by df, so multiplying by the correction factor changes the 
shape of the F distribution and results in a new critical value to compare observed F to. Note that it doesn’t 
change observed F, just critical F and the resulting p value. [In case you’re curious, it doesn’t affect observed F 
because e shows up in both the numerator and denominator of the F ratio, and therefore cancels out.] 
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Next you’ll see the ANOVA source table: 
 

 
 
To determine whether your F is significant, examine the p value in the appropriate row of the source 
table depending on whether you applied the Greenhouse-Geisser or Huynh-Feldt correction. In this case, 
we used the Greenhouse-Geisser e, so our p value would be .019 (significant). In your APA-style write-
up, report the df associated with the “Sphericity Assumed” row even if you are using one of the 
correction factors (i.e., don’t report fractional df). But be sure to report the appropriate p value that 
corresponds to the correction factor you chose.  
 
 
Our F was significant, so next we must examine the post-hoc comparison of means (see below): 
 

Recall that we selected Bonferroni 
comparisons. The Bonferroni 
approach allows us to run multiple 
comparisons while still controlling the 
Type I error rate. Because there were 
three possible pairwise comparisons, 
the original p values were multiplied 
by 3. (If there had been 4 pairwise 
comparisons, the original p values 
would have been multiplied by 4.) If 
these new (higher) p values in the 
table above are less than .05, the 
comparison is significant.  

 
 
The “1,” “2,” and “3” for modality are determined by the order in which you entered them into the 
repeated-measures dialog box in SPSS: 1 = visual only, 2 = auditory only, and 3 = visual+auditory. Here 
we see that the only significant difference was between auditory and visual+auditory.  
 
To understand the nature (direction) of the difference, you must examine the means in the descriptive 
statistics box that appeared earlier in the output. From there, we can see that recall was significantly 
poorer for the auditory-only condition than for either the visual or visual+auditory conditions, which 
didn’t differ from each other.  
 
Note that the 95% confidence interval has also been Bonferroni-adjusted. 
 

SPSS does not include 
the total SS or total df, 
so the table looks a little 
different than when you 
compute the ANOVA 
by hand. 
 
You are given partial η2  
(.34), which is what you 
would get if you 
computed SSB/SSB + 
SSE. 
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Sample APA-Style Results Section: 
 

A one-way repeated measures ANOVA was conducted on word recall as a function of modality 

of presentation (visual only, auditory only, or both visual and auditory). Mauchly’s test indicated that the 

assumption of sphericity was violated, c2 (2) = 9.98, p = .007, so the degrees of freedom were corrected 

using the Greenhouse-Geisser estimate of sphericity (e = .63). There was a significant effect of modality, 

F(2, 24) = 6.25, p = .019, partial η2 = .34. Post-hoc pairwise comparisons using the Bonferroni 

correction indicated that average recall was significantly better when words were presented in both 

modalities (M = 4.85, SD = 2.04) than when they were presented only auditorily (M = 3.15, SD = 1.99), 

p = .006; 95% CI [0.50, 2.89]. Recall did not differ between words presented visually (M = 5.92, SD = 

2.06) and those presented either auditorily, p = .053; 95% CI [-0.03, 5.57], or in both modalities 

combined, p = .641, 95% CI [-1.20, -3.36]. 

 
Note: If Mauchly’s test is not significant, it’s still recommended to apply the correction factor. In 
that case, you’d write something like the following: Mauchly’s test indicated that the assumption of 
sphericity was not violated, c2 (2) = 1.13, p = .439, but because the test is highly sensitive to sample 
size, the degrees of freedom were still corrected using the Greenhouse-Geisser estimate of sphericity (e 
= .63). 

 

Important details for writing a Results section involving a repeated-measures ANOVA:  
● Italicize M, SD, F, and p.   
● Don’t forget to write the degrees of freedom, between and within, in parentheses.  
● Round M, SD, and F to 2 decimal places. 
● Report p to 3 decimal places. Always provide the exact p value (e.g., p = .004) unless p < .001, in which 

case you simply write p < .001.  
● When p > .05, report that the F value was NONsignificant, not INsignificant. Report the exact p value 

even if the test is not significant. 
● Use a leading zero for numbers less than one that can take on values less than or greater than 1 (or -1). 

Notice that I used leading zeroes for some of the values in the CIs. Note that epsilon and partial η2 do 
NOT get a leading zero because their maximum value is 1. 

● Report the results of the Mauchly test as shown above and note which correction factor you used.  
● Indicate whether the overall F was significant. If so, report the value of partial η2 and discuss the results 

of the Bonferroni-corrected pairwise comparisons. In describing the pattern of results, be sure to state the 
direction of the differences. Report the Ms and SDs of each group in parentheses and include the 95% 
confidence intervals for the differences between group means. Be sure your wording makes it clear that it 
was a within-subjects design (i.e., do not talk about different groups). 

● There is no need to provide the M and SD for the same group twice (i.e., if you are comparing that group 
to two different groups, you only need to provide the descriptive statistics the first time you mention that 
group).
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SPSS Instructions for Correlation and Regression 
 
For our correlation and regression example, we’ll use data from the “Monitoring the Future” national 
survey of twelfth graders conducted by the Inter-university Consortium for Political and Social Research 
(ICPSR). Let’s imagine we were interested in the extent to which students’ self-reported intelligence and 
school ability predict their liking for school. So there are two predictor variables (intelligence, school 
ability) and one criterion variable (liking for school). 
 
Correlation 
Before we conduct a regression to determine whether our predictor variables predict our criterion, it’s a 
good idea to examine the bivariate correlations between each pair of variables. Before you do that, 
however, it’s important to examine a scatterplot of your variables to get an idea about whether they are 
linearly related to one another.  
 
To demonstrate, we’ll look at the scatterplot for the relation between perceived school ability and liking 
for school. [Note that one should look at the scatterplots for all possible pairs of variables before running 
bivariate correlations]. To produce a scatterplot in SPSS, go under the “Graphs” menu to “Legacy 
Dialogs” and choose “Scatter/Dot…” You will see the window in Figure 1. Choose “Simple Scatter” (it 
should already be selected) and click on “Define.” You will now see a window like the one in Figure 2. 
 

 
 
 
 
 
 
 

  
   
  

Figure 1 
 
  
 
 Figure 2 
 

Scroll down the list of variables on the left until you find the variable you want on the Y axis (the 
criterion variable; in this case, “like_school”). Click on this variable, then click the top arrow. The 
variable name should now appear in the box labeled “Y Axis.” Now find the variable you want on the X 
axis (the predictor variable; in this case, “school_ability”). Click on this variable, then click on the arrow 
next to the “X axis” box. Click OK. SPSS will bump you into the output window, where you’ll see your 
scatterplot. Take a look at it. Are there any outliers? Does the relationship appear linear? (If it’s 
curvilinear, a Pearson’s r is inappropriate to use.) Double-click on the graph, and when SPSS bumps you 
into the chart editor, go under the “Elements” menu and choose “Fit line at total.” [You can close the 
“Properties” box if it pops up.] SPSS will draw in the least-squares line, which will better help you see 
whether the data are linearly related, and whether the relationship is positive or negative. [Note that if 
you are correlating variables measured on rating scales with only a few levels, say a 1-5 scale, the 
scatterplot may look a little wonky because the options for where points might fall are limited.] 
 
If your scatterplots look OK, you’re ready to calculate correlations. To do so, go to the “Analyze” menu, 
scroll down to “Correlate” and choose “Bivariate.” You will see a window like the one in Figure 3. 
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Find the variables you want from the list on 
the left and click the arrow to place them in 
the box labeled “Variables.” Here I’ve 
entered all three variables of interest. Note 
that you can put as many variables into a 
correlation matrix as you like. 
 
Under “Correlation Coefficients,” make sure 
that “Pearson” is selected (this is the 
default).   
 
Click on “Options” and check the box that 
will give you means and SDs for the two 
variables.  
 

Here you are provided with the 
following correlations: 
 
1. liking for school & school ability  
    (r = .21) 
2. liking for school & intelligence 
    (r = .16) 
3. school ability & intelligence 
    (r = .72) 
 
The diagonal of 1s just shows each 
variable correlated with itself. 

Click on “Confidence interval” and you will get the 
dialog box shown at right in Figure 4. Check the 
first box as shown and the “Apply the bias 
adjustment” box to get bias-adjusted confidence 
intervals for the correlation. 
 
Click “OK” and SPSS will bump you into the 
output window (see below). 
 

Figure 3 

Figure 4 
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You’ll note that this matrix produces redundant information, with the same correlations provided both 
above and below the diagonal. For each group of three numbers (e.g., like_school correlated with 
school_ability) the top value is Pearson’s r (the correlation). Below that, the “Sig (2-tailed)” value is the 
p value, or the probability of getting a correlation that big or bigger if there really was no relationship 
between the two variables in the population. Finally, the bottom number is N (the sample size). Note that 
even though two of these correlations are quite small, they are highly significant because of the very 
large sample size. 
 
 

 
 
 
 
Regression (one predictor) and Multiple Regression (two or more predictors) 
If two variables are significantly correlated, then scores on one variable can be used to predict scores on 
the other. To conduct a linear regression in SPSS, go under “Analyze,” “Regression,” “Linear” and 
you’ll see a window like the one in Figure 5. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5 
 
In the “Model Summary” table (see below), note that R is provided, which represents the correlation 
between observed and predicted Y values; it can range from 0 to 1. (Note the difference between lower 
case r and capital R.) The R Square is the coefficient of determination and ranges from 0 to 1. R Square 
represents the total variability in Y explained by all of the predictor(s). (Adjusted R square adjusts for 
the number of predictors in the model; when there are a large number of predictors and a small N, the 
difference between R square and adjusted R square is larger; we won’t worry about it here.) 
 

Put the criterion (Y) variable in the box 
labeled “Dependent” and all the predictor 
(X) variables in the box labeled 
“Independent(s).” Click OK and you’ll be 
bumped to the output window. 

The next part of the output 
provides the bias-corrected 
confidence intervals for all three 
correlations. As you can see, 
because all three of these 
correlations are significant, none of 
the confidence intervals include 
zero. 
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The ANOVA table indicates whether the overall model is significant. It can be interpreted just like a 
regular ANOVA table, with the “regression” row representing the predictors (analogous to the 
“between-subjects” row) and the “residual” row representing the error. Here, p < .001, so the two 
predictors together significantly predict liking for school. 
 

 
 
In the “Coefficients” table you’ll see numbers listed under the “B” column for your predictor variables 
and for (Constant). For your predictor variables, these numbers represent the unstandardized slopes—
they are the slopes expressed in the original units of each variable and can be plugged into the regression 
equation to predict 𝑌" . The number under B next to (Constant) is the Y intercept of the regression line. 
The standardized Beta coefficients are a standardized version of a slope (like a Z score) – they refer to 
how many standard deviations a dependent variable will change, per standard deviation increase in the 
predictor variable; because they are independent of the original units, they can be easily compared. The 
larger the β, the stronger the relationship. With only one variable in the equation, β = r. You can write 
the regression equation based on this output, using the Bs for the slopes: 𝑌"  = 2.00 + 0.03x1 + 0.17x2. (If 
the Bs had been negative, you would have used the minus sign instead of the plus sign.) 
 
Notice that, although each of the predictors independently predicts liking for school (i.e., the bivariate 
correlations were significant), because there was such a high correlation between the two predictors 
perceived school ability and perceived intelligence (r = .72 from the correlation table), when we put both 
predictors in the equation to predict liking for school, intelligence is no longer significant (p = .346), 
whereas school ability remains significant (p < .001).  
 

The Standard Error of the Estimate 
estimates the amount of error we have 
when using the predictors to predict Y. It 
is the square root of the Mean Square 
residual in the ANOVA table below. 
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Sample APA-Style Results Section for Correlation/Regression: 
 

Self-reported school ability (M = 4.91, SD = 1.23) and intelligence (M = 5.01, SD = 1.24) were 

both significantly positively correlated with liking for school (M = 2.99, SD = 1.12), r(1789) = .21, p < 

.001, bias-corrected 95% CI [.16, .25] for school ability and r(1792) = .16, p < .001, bias-corrected 95% 

CI [.12, .21] for intelligence. The overall regression model predicting liking for school from both school 

ability and intelligence was significant, F(2, 1781) = 40.95, p < .001, R2 = .04 (standard error of estimate 

= 1.10). With both variables in the equation, self-reported school ability significantly predicted liking for 

school (b = 0.17, p < .001), but perceived intelligence did not (b = 0.03, p = .346).  

 
Note: There is no need to report r2 values for the bivariate correlations, as these are easily computed by 
the reader if desired. More important is to present the R2 value from the regression if there are two or 
more predictors.  
 
Once you get beyond just a couple of predictor variables, the text starts to become so cluttered with 
numbers that it’s better to present them in a table. For example, you could present one table with the 
means, SDs, bivariate correlations, and bias-adjusted 95% confidence intervals (see handout for how to 
do that), and a second table with the b and p values for each predictor in the multiple regression. Be sure 
to refer to the table in the text (e.g., “As shown in Table 1…”) and then do not include those values in 
the results section. 
 
 
Important details for writing a Results section involving correlation/regression:  

● Italicize M, SD, r, p, F, and b. 
● Note that for a correlation, df = N-2 
● Be sure to include the r, df, p value, the M and SD for each variable, and the value of R2 for a multiple 

regression with two or more predictors. 
● Round M, SD, r, F, R2, and b to 2 decimal places.  
● Report p to 3 decimal places. Always provide the exact p value (e.g., p = .004) unless p < .001, in which 

case you simply write p < .001.  
● When p > .05, report that the finding was NONsignificant, not INsignificant. Report the exact p value 

even if the test is not significant. 
● Use a leading zero for numbers less than one that can take on values less than or greater than 1 (or -1). 

Notice that I used leading zeroes for the unstandardized slopes. 
● Typically, we do not write out the regression equation, but might include the important values in a table if 

there are a lot of predictor variables. 
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SPSS Instructions for a Chi-Square 
 

The MacArthur “Genius” award winner Elizabeth (Betsy) Levy Paluck’s research on bullying has 
demonstrated that an effective way to reduce bullying in middle schools is to identify students with a 
great deal of social influence among their peers and provide them with an intervention encouraging them 
to take a stance against bad behavior in their school. Imagine that one school received this social 
influence intervention, one received a traditional anti-bullying education intervention, and one received 
nothing (control). The behavior of 100 students at each of the three schools was monitored for 8 months 
afterwards to see if any bullying occurred. [Note: because one of the variables has marginal frequencies 
that are fixed—100 people in each of the three conditions—the test would be a chi-square test of 
homogeneity.]   The data would be entered as shown in Figure 1, with one column for the IV, one 
column for the DV, and a column of frequencies specifying the number of participants in each IV/DV 
combination. 
 

 
Figure 1 
 
Note that, instead of entering the data this way, you could have entered 300 rows of data, one for each 
participant (or you could be working with an existing data set that has one row for each participant). For 
this example there would be four rows in which condition = 1, bullying = 1 to represent the four 
participants in the social influence intervention condition who bullied. Then there would be 96 rows of 
condition = 1, bullying = 2, and so on. That’s a bit cumbersome when entering data just for a chi-square 
test, so instead we simply delineated the six combinations and listed the frequencies with which each 
occurred. Because of that, however, we now need to tell SPSS to weight the cases (i.e., rows) by their 
frequencies. To do so, go to the Data menu, then all the way down to the bottom to “Weight Cases”. 
You’ll get the box shown in Figure 2: 
 

 
Figure 2 

Condition 1 = social influence intervention 
Condition 2 = traditional intervention 
Condition 3 = no-intervention control 
 
Bullying:  1 = did bully; 2 = did not bully 
 
Here you can see that only 4 students in the social 
influence intervention condition engaged in 
bullying, compared with 15 in the traditional 
intervention and 17 in the control condition. 

Select “Weight cases by” and move “frequencies” into 
the “Frequency Variable:” box, then click OK. 
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Once the data are entered (and cases are weighted, if necessary), go to the “Analyze” menu, scroll down 
to “Descriptive Statistics,” and then select “Crosstabs.”  You will see a window like the one in Figure 3 
below. Select bullying as the row variable and condition as the column variable (it doesn’t matter which 
is which). 
 

 
Figure 3 
 
Click on the “Statistics” button and you will see a box like the one in Figure 4 below. Select “Chi-
Square” as well as “Phi and Cramer’s V” under “Nominal” and then click “Continue.”  Then click on 
the “Cells” button and you will see a window like the one in Figure 5 below.  “Observed” is already 
selected under “Counts,” but you also need to select “Adjusted standardized” under “Residuals” and 
then click “Continue.”   
 

       
Figure 4      Figure 5 
 
 
Click the “OK” button and you will get bumped to the output window where your output will look like 
the following: 
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The first table provides the observed counts for your cells as well as the adjusted standardized residuals, 
which you use to determine the nature of the relationship if the chi-square is significant. More on that in 
a moment.  
 
The second table provides the chi-square statistic, df, and p-value in the first row and the total N in the 
last row. The other two rows can be ignored. In this case, it appears that the chi-square statistic is 
significant, as p = .010. Now we can go back to the first table and determine the nature of the effect by 
interpreting the adjusted standardized residuals. 
 
If the value for the adjusted standardized residual for a cell is greater than the absolute value of 1.96 
(i.e., the z-score that cuts off 5% of the distribution), then the observed frequency significantly differs 
from the expected frequency for that cell—i.e., the cell is contributing to the nature of the effect.  
 
In this case, it appears that the number of people who bullied (vs. didn’t) in the social network condition 
is different from what would be expected by chance (adjusted standardized residual = -3.0/+3.0). 
However, the residuals indicate that the counts for the traditional intervention and control conditions 
don’t differ from chance (adjusted standardized residuals were less than |1.96|). You could interpret this 
pattern as demonstrating that there was significantly less bullying than expected following the social 
influence intervention than following either the traditional intervention or no intervention.  

 
 
 
 
 
 
 
 

 
 

The final table provides Phi (Φ) and Cramer’s V 
statistics, which you use to interpret the strength of a 
significant relationship (use Φ for 2 x 2 tables and 
Cramer’s V for tables larger than 2 x 2). Both vary 
between 0 and 1. 
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The table below (from p. 601 of the Privitera text) lists norms that can be used to interpret Φ/Cramer’s 
V; dfsmaller is the df of the variable with the fewer levels.  
 
 

 
 
 
Sample APA-Style Results section: 
 

A chi-square test of the relationship between intervention condition (social network vs. 

traditional vs. control) and bullying behavior was statistically significant, χ2(2, N = 300) = 9.28, p = 

.010, Cramer’s V = .18. Students were less likely to bully and more likely not to bully than expected in 

the social influence intervention condition, but not in the traditional intervention or control conditions. 

 

Important details for writing a Results section involving correlation/regression:  
● Italicize N, p, and V. 
● Round χ2 and V to 2 decimal places.  
● Report p to 3 decimal places. Always provide the exact p value (e.g., p = .004) unless p < .001, in which 

case you simply write p < .001.  
● When p > .05, report that the finding was NONsignificant, not INsignificant. Report the exact p value 

even if the test is not significant. 
● Use a leading zero for numbers less than one that can take on values less than or greater than 1 (or -1). 
● Be sure to describe all cells that contribute to the nature of a significant effect (e.g., less likely to * and 

more likely not to *) 
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Figure 2 

SPSS Instructions for a 3 x 2 Factorial ANOVA 
 
When people are given a display of objects (e.g., an apple) to memorize and later recall, they typically recall more 
when given a recall cue, whether spatial (location of the object; e.g., top left) or semantic (word related to the 
object; e.g., pie). Because the medial temporal lobes are involved in memory, one would expect that people with 
damage to the medial temporal lobes would perform poorly on a free recall task. In addition, because the temporal 
lobes are also involved in spatial processing, a spatial cue should not help people with medial temporal lobe 
lesions. A neuroscientist gave 15 control participants and 15 participants with a medial temporal lobe lesion 36 
objects to memorize. Participants in each group were randomly assigned to receive a spatial cue, a semantic cue, 
or no cue upon recall.  Number of objects recalled was recorded for each participant. What do the data suggest? 
 
  No cue Spatial cue Semantic cue 
 Control participants 15 

17 
11 
15 
18 

18 
34 
25 
30 
17 

18 
19 
23 
17 
32 

 Participants with 
temporal lobe lesion 

9 
5 
6 
3 
2 

9 
6 
4 
1 
3 

22 
21 
30 
34 
21 

 
The first thing you need to do is to figure out how to get these data into SPSS. You have 2 IVs and one 
DV, so you’ll need 3 columns of data: participant type (1 = control, 2 = lesion), cue condition (1 = no 
cue, 2 = spatial cue, and 3 = semantic cue), and number of objects recorded.  Next, you need to do the 
overall factorial ANOVA. Go up to the Analyze menu to General Linear Model. Choose Univariate (for 
one dependent variable).  When the window (pictured below) comes up, put the dependent variable 
(which I’ve called “recall”) into the appropriate box. Next, enter each factor (IV) into the “Fixed 
Factor(s)” box.  
 

 
 
 
 

Next, click on “Options” 
and then click on 
“Descriptive statistics” 
(see Figure 2) to get Ms 
and SDs for each 
condition. Then click 
“Continue”.  
 

Do NOT select “Estimates of effect size”. It will produce partial η2 values for each predictor 
(SSB/SSB + SSerror) rather than just η2 values (SSB/SStotal). You’ll need to compute η2 by hand. 
 

Figure 1 
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Next, to get the 95% confidence interval for the 
difference between the means for the variable with 
2 levels, select “EM Means” from the initial 
ANOVA window (see Figure 1). You will get the 
dialogue box shown in Figure 4. Select partic_type 
and click the arrow to put it in the “Display Means 
for” box. Check the “Compare main effects” box. 
You don’t need a CI adjustment (i.e., Bonferroni) 
because there’s only one comparison. Click 
“Continue” to go back to the initial ANOVA 
window, and then “Continue” to get bumped to the 
output window. 

Because the cue variable has more than two levels, 
you should click on “Post Hoc” in the initial ANOVA 
window (see Figure 1) and click on the “Tukey” box 
(see Figure 3). If the cue main effect is significant, 
you will be able to see how the three means differ 
from one another. Click “Continue” and then “OK”. 
 

Figure 3 

Figure 4 

Looking at the source table, disregard the first two 
rows, and focus only on the rows for the 2 IVs, the 
interaction, error, and corrected total. There’s a sig. 
main effect for participant type, a sig. main effect for 
cue condition, and a sig. participant x cue interaction. 
Note that the interaction may qualify the main effects, 
so we need to determine that when we look at the 
nature of the interaction.  
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Understanding the Nature of the Main Effects 
 
Participant type main effect: Looking at the means in the descriptive statistics box (above), we can see 
that those with a temporal lobe lesion recalled significantly fewer objects than did controls. The 95% CI 
can be found in the pairwise comparisons box that you get when you click on EM Means (see below). 
Note that you get the same CI twice; just pick one. (In other words, [5.06, 12.67] is the same as [-12.67, 
-5.06].) 
 

 
 
Cue condition main effect: Because the cue variable has three levels, you need to examine the output 
from the Tukey test to understand it. 
 

  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

The nature of the main effect for cue is such 
that participants provided with a semantic cue 
performed significantly better than did those 
provided with either a spatial cue or no cue, 
who did not differ from each other.  

As with the one-way ANOVA, you 
can find the 95% CIs here in the 
Tukey output.  
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Understanding the Nature of the Interaction (examining the “simple effects”) 
 
Because there’s a significant interaction, we know that participant type and cue type work together to 
affect recall. Just eyeballing the means, it looks like recall is much worse in the no cue and spatial cue 
conditions, but only for participants with a temporal lobe lesion. Of course, you know that we can’t just 
assume this pattern; we need to actually check it out by testing the significance of the simple effects. We 
could do this in one of two ways:  
 
1. Examine the effect of cue type on recall for each type of participant (i.e., compare no cue vs. spatial 

cue vs. semantic cue for control participants and again for participants with a lesion). Two one-way 
ANOVAs 
 
OR 
 

2. Examine the effect of participant type on recall within each cue type (i.e., control vs. lesion 
participants for no cue, spatial cue, and semantic cue).  3 independent-samples t tests 
 

Either comparison is OK, but you shouldn’t do both. Let’s look at the first option and conduct two one-
way ANOVAs. 
 
To do so, we need to use the “split file” command in SPSS. We’ll split the file on participant type. Now, 
any test that we run in SPSS will be run separately for control participants and lesion participants. For 
our purposes, we’ll conduct a one-way ANOVA on recall as a function of cue condition. The “split file” 
command will give us two one-way ANOVAs: one for control participants and one for lesion 
participants. 
 
Go to the “Data” menu and choose “Split file” (it’s toward the bottom). You’ll see the window below: 
 

  
 

 
 

Click on “compare groups” and select “partic_type,” then 
the right arrow to put it into the box labeled “Groups Based 
on:”. Then click OK. SPSS will now conduct all analyses on 
control participants and lesion participants separately.  
 
 
 
 
 
 
 
 

Next, you’ll need to conduct a one-way ANOVA 
examining the effect of cue type on recall. Go to 
“Analyze,” “Compare Means and Proportions,” “One-
Way ANOVA” and put in recall in the Dependent List 
(DV) and cue_cond as the Factor (IV). Note that 
you’ve split the file on partic_type, so you cannot use it 
in the analysis. 
 
Be sure to select the Tukey test from the Post-Hoc 
menu so you can see which of the 3 cue types differ 
within each type of participant. 
 
You’ll get the output shown below. 
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For the participants with a lesion, providing 
semantic cues resulted in significantly better 
recall than providing either spatial cues or no 
cues, which did not differ from each other. 
Thus, the main effect of type of cue was 
qualified by the significant interaction. The 
pattern holds only for the participants with a 
temporal lobe lesion. 

For the control participants, there 
was no significant effect of cue 
type on recall (p = .058). For the 
participants with a lesion, there 
was a significant effect of cue 
type on recall (p < .001). We need 
to examine the Tukey test to 
interpret the nature of the effect of 
cue type on recall for the 
participants with a lesion. 

The ANOVA was not significant for the 
control participants, so that post-hoc test 
does not need to be interpreted (notice 
that SPSS prints it out anyway; you have 
to know better not to look at it!) 
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Sample APA-Style Results Section (note that you don’t need to mention splitting the file): 
 

A 2 (condition: control vs. participants with a temporal lobe lesion) x 3 (type of recall cue: spatial, 

semantic, none) between-subjects factorial ANOVA was conducted on number of objects recalled from an 

array. As predicted, there was a significant main effect of condition, F(1, 24) = 23.17, p < .001, η2 = .20, 

such that participants with a temporal lobe lesion recalled significantly fewer objects (M = 11.73, SD = 

10.87) than did participants in the control condition (M = 20.60, SD = 6.76); 95% CI [5.06, 12.67]. The main 

effect of cue type was also significant, F(2, 24) = 18.80, p < .001, η2 = .33. A Tukey HSD test indicated that 

participants provided with a semantic cue (M = 23.70, SD = 6.08) performed significantly better than did 

those provided with either a spatial cue (M = 14.70, SD = 11.91), p = .022; 95% CI [3.37, 14.63] or no cue 

(M = 10.10, SD = 5.95), p < .001; 95% CI [7.97, 19.23], who did not differ from each other; p = .125; 95% 

CI [-1.03, 10.23].  

 These two main effects were qualified by a significant interaction between condition and cue type, 

F(2, 24) = 14.28, p < .001, η2 = .25. To understand the nature of the interaction, two one-way between-

subjects ANOVAs comparing cue type were conducted: one for control participants and one for participants 

with a temporal lobe lesion. As shown in Figure 1, for control participants, the one-way ANOVA was not 

significant, F(2, 12) = 3.63, p = .058. There was no significant difference in number of objects recalled 

between those provided with no cue (M = 15.20, SD = 2.68) and those provided with either a spatial cue (M 

= 24.80, SD = 7.40), p = .053; 95% CI [-19.32, 0.12] or a semantic cue (M = 21.80, SD = 6.14), p = .208; 

95% CI [-16.32, 3.12], nor was there a difference in recall between those provided with a semantic versus a 

spatial cue, p = .696; 95% CI [-6.72, 12.72]. In contrast, the one-way ANOVA for participants with a 

temporal lobe lesion was significant, F(2, 12) = 40.75, p < .001. A Tukey HSD test indicated that, as 

hypothesized, participants with a temporal lobe lesion performed significantly better on the recall task when 

provided with a semantic cue (M = 25.60, SD = 6.03) than those provided with either a spatial cue (M = 4.60, 

SD = 3.05, p < .001; 95% CI [13.90, 28.10]) or no cue (M = 5.00, SD = 2.74, p < .001; 95% CI [13.50, 

27.70]), who did not differ from each other, p = .988; 95% CI [-7.50, 6.70]. 
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Figure 1 

Mean Recall as a Function of Lesion Condition and Cue Condition 

 

Note. Error bars represent one standard error above and below the mean. 

Important details for writing a Results section involving a factorial ANOVA:  
● Italicize M, SD, F, t (if using t-tests to understand the nature of an interaction) and p.   
● Don’t forget to write the degrees of freedom, between and within (error), in parentheses.  
● Round M, SD, F, t, η2, and CI to 2 decimal places.  
● Report p to 3 decimal places. Always provide the exact p value (e.g., p = .004) unless p < .001, in which case 

you simply write p < .001.  
● When p > .05, report that the finding was NONsignificant, not INsignificant. Report the exact p value even if 

the test is not significant. 
● Use a leading zero for numbers less than one that can take on values less than or greater than 1 (or -1). Note 

that η2 does NOT get a leading zero because its maximum value is 1. 
● First indicate whether or not any of the main effects were significant. If so, report the value of η2 and describe 

the nature of the significant effect(s), including the results of any post hoc Tukey HSD test(s). In describing the 
pattern of results, be sure to state the Ms and SDs of each group in parentheses; however, there is no need to 
provide the M and SD for the same group twice (i.e., if you are comparing that group to two different groups, 
you only need to provide the descriptive statistics the first time you mention that group). 

● Next indicate whether or not the interaction was significant. If so, report the value of η2 and indicate if the 
interaction qualified the main effect(s) (if not, simply state that the interaction was significant). For a 
significant interaction, next describe the analyses you conducted to determine the nature of the interaction. Be 
sure to refer to a Figure when describing the pattern of results. Report Ms, SDs, 95% CIs, and F or t 
statements, but do not report strength for any significant F or t tests conducted solely to determine the nature of 
a significant interaction because you already reported η2 for the interaction itself. 

● Don’t forget to include confidence intervals, where appropriate. 
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The figure you create 
should be consistent 
with the way you 
split the file. Here, 
we’re comparing cue 
type within each 
participant type. If 
you’d done three t 
tests, you’d want the 
cue type on the X-
axis and participant 
type as the different 
shaded bars. 
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 SPSS Instructions for a 2 x 2 Factorial ANOVA 
 
Imagine that an educational psychologist was interested in assessing the effects of two different ways of 
teaching math (Method A and Method B). She assumed that Method B would be better than Method A, 
but only for kids who were struggling in math. For kids who typically do well in math, both methods 
should be equally effective.  Her data appear below (numbers indicate scores on the last math test): 
 
  Method A Method B 
 Kids who struggle 75 65 

70 55 
80 82 
68 73 
64 53 

85 86 
82 90 
79 86 
77 80 
70 91 

 Kids who do well 88 85 
84 90 
88 96 
94 91 
85 81 

92 96 
84 82 
97 80 
79 95 
87 89 

 
Enter the data into SPSS as you did for the 3 x 2 factorial ANOVA.  
 
Conduct the factorial ANOVA as you did for the 3x2, with math score as your dependent variable and 
kid type and method as your fixed factors. Be sure to select “Descriptive statistics” from the Options 
menu to get your means and standard deviations. You don’t need to select “Post Hoc” from the initial 
ANOVA window because each of your IVs has only 2 levels. You can determine the nature of each 
significant main effect by simply examining the means. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click OK in the initial ANOVA window and you will get the output pictured below: 

Click on the “EM Means” button to get the dialog box 
shown at right. Enter the two main effects into the 
“Display Means for” box. Click “compare main 
effects” and leave the confidence interval adjustment 
at “LSD(none)”. Click “continue”. This will give you 
the 95% confidence intervals for the main effects. 
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Understanding the Nature of the Main Effects 
 
Note that because each of factor has just two levels, you can understand the nature of each significant 
main effect simply by examining the means. You can find them in the “Descriptive Statistics” box (see 
above). 
 
First, looking at the main effect for kid, it appears that the mean for kids who typically do well (88.15) is 
higher than the mean for kids who typically struggle (75.55). This finding isn’t too surprising.  
 
Next, looking at the main effect for method, you can see that Method B (M = 85.35) results in higher 
math scores than Method A (M = 78.35).  
 
Use the pairwise comparisons boxes (see below) to get the 95% confidence interval for each main effect 
(it’s given twice; just pick one). 
 

 

 

So, it looks like we have 2 
significant main effects and a 
significant interaction. 
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Understanding the Nature of the Interaction (examining the “simple effects”) 
 
As in the case of the 3 x 2 ANOVA, you have two options: 
 
1. Examine the differences in Method type (A vs. B) within each “kid type”. 

 
OR 
 
2. Examine the differences in “kid type” within each method type. 
 
Because each variable has just two levels, each option is accomplished with two independent samples t 
tests. Again, you should pick one option. Let’s look at Option 1. 
 
To do so, we will need to ask SPSS to split the file on “kid type” and conduct two t tests comparing 
Method A to Method B: one for kids who do well and one for kids who struggle.  
 
Go to the “Data” menu and choose “Split file”. You will see the window below: 
 

  
 

Click on “compare groups” and select “kid,” then the right 
arrow to put it into the box labeled “Groups Based on:”. 
Then click OK. SPSS will now conduct all analyses on kids 
who do well and kids who struggle separately.  
 
 
 
 
 
 
 
 

So, the 95% CI for the “kid type” 
variable is [-17.14, -8.06]. 
 
The 95% CI for the Method 
variable is [-11.54, -2.46]. 



   

56 

 
 

 
 

 
 
As you can see, the t value is significant for kids who struggle, but not for kids who do well. (Remember 
to use the two-sided p value.) By looking at the means, we see that Method B is superior to Method A 
for kids who struggle, but the methods are equally helpful for kids who do well.  
 
This interaction qualifies the main effect for method: That is, although it appeared that, overall, Method 
B was more effective than Method A, we know from examining the interaction that Method B is better 
only for kids who struggle. Thus, we wouldn’t want to make any general statement about Method B 
being better for everyone. (This is what it means for an interaction to qualify a main effect.) It’s 
probably still safe to interpret the main effect that kids who typically do well do better than kids who 
typically struggle, regardless of teaching method. 
 
 
Notice that in the sample results section below, you do not need to explicitly state that you split the file. 
Just make it clear which comparisons you examined.  

Next, you’ll need to conduct an independent-groups t 
test examining the effect of method on score. Go to 
“Analyze,” “Compare Means,” “Independent Samples t 
Test” and put in mscore as the Test Variable (DV) and 
method as the grouping variable (IV). You’ll need to 
indicate that method is coded as 1 or 2. 
 
You’ll get the output shown below. 
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Sample APA-Style Results Section: 
 

A 2 (teaching method: Method A vs. Method B) x 2 (student skill level: struggling vs. doing 

well) between-subjects factorial ANOVA was conducted on math exam scores. There was a significant 

main effect of teaching method, F(1, 36) = 9.78, p = .003, η2 = .11, such that students who were 

instructed with Method B (M = 85.35, SD = 6.98) performed better on the math test than did students 

who were instructed with Method A (M = 78.35, SD = 12.50); 95% CI [-11.54, -2.46]. As predicted, the 

main effect for type of student was also significant, F(1, 36) = 31.69, p < .001, η2 = .36, such that 

students who struggle with math (M = 75.55, SD = 10.74) performed worse on the math exam than did 

students who do well with math (M = 88.15, SD = 5.64); 95% CI [-17.14, -8.06]. 

 The main effect of teaching method was qualified by a significant interaction between teaching 

method and type of student, F(1, 36) = 10.06, p = .003, η2 = .11. To understand the nature of the 

interaction, two independent-groups t tests, comparing Method A to Method B, were conducted: one for 

students who do well in math and one for students who struggle. As seen in Figure 1, and consistent 

with the hypothesis, for students who do well, there was no significant difference in math exam scores 

for those instructed with Method A (M = 88.20, SD = 4.66) and those instructed with Method B (M = 

88.10, SD = 6.74), t(18) = .04, p = .970; 95% CI [-5.35, 5.55]. However, students who struggle in math 

performed significantly better on the math exam when instructed with Method B (M = 82.60, SD = 6.36) 

than with Method A (M = 68.50, SD = 9.63), t(18) = -3.86, p = .001; 95% CI [-21.77, -6.43]. 
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The figure you create (see below) should be consistent with the way in which you split the file. Because 
we compared the two methods within the two levels of “kid type,” the figure below is organized so that 
the reader can compare the method bars (which should touch each other) for each type of child. If you 
had split the file the other way, you would need to have the two method types on the x-axis and the two 
“kid types” as the differently-shaded bars.  
 
Excel Tip: You can easily swap which variable is on the x-axis and which in the legend by clicking on 
the graph, going to the “Chart Design” toolbar, and selecting “Switch Row/Column.” See separate 
handout for how to create the figure in Excel. 
 

Figure 1 

Mean Math Test Score as a Function of Teaching Method and Past Experience 

 

Note. Error bars represent one standard error above and below the mean. 
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APPENDIX A - Psych./Neuro 201 (Statistics & Research Methods in Psychology) 
Creating APA-Style Tables in Microsoft Word 

 
A table can be an efficient way of communicating a lot of information in a small amount of space. It 
should be able to stand on its own, and should not be redundant with material presented in the text of 
your paper. It is not difficult to create a table in Microsoft Word, but there are a few tricks to making it 
conform to APA style. See https://apastyle.apa.org/style-grammar-guidelines/tables-figures/sample-
tables or pp. 201-224 of the Publication Manual of the APA (7th ed.) for sample tables in APA style. 
Below are the basic elements of an APA-style table. 
 
The Elements of an APA-Style Table 
 

• Table number (in bold). Tables are numbered with Arabic (i.e., regular) numerals in the order 
they appear in the paper. 

 
• Table title (italicized). The table title should be one double-spaced line below the table number. 

Capitalize the first letter of major words, and do not end with a period. The title should be 
descriptive, but succinct. 

 
• A horizontal line separates the table title from the column headings. 
 
• Column headings (labels centered over each column). Use upper- & lower-case. 
 
• A second horizontal line separates the column headings from the table data. 
 
• Data for your table go next. The table can be double-spaced or not, depending on how much 

information you need to convey. 
 
• End your table with a final horizontal line beneath the last row of data. The three horizontal lines 

listed above are the only three lines you should have in your table. You should not have any 
vertical lines. 

 
• Table notes go one double-spaced line beneath the final horizontal line. Begin with the word 

Note (in italics) followed by a period. General table notes are used to explain abbreviations or 
provide additional information. (See pp. 203-204 of the APA manual for an explanation of 
general, specific, and probability notes, and how to format them.) 

 
An Example Table of Descriptive Statistics 
 
Below we will walk through an example for a simple table of means and standard deviations. The table 
represents respondents’ average enjoyment rating for a variety of activities. 
 
First, we need to think about how we want to organize all this information. This step is the most 
important in creating a good table. Sketch it out for yourself before beginning. It makes sense to list all 
the variables down the left-most column, and then have two more columns next to that one, one for the 
means and one for the SDs.  
 
The table below is formatted in APA style. Following it are instructions for how to create it in Microsoft 
Word. Notice that there is a table “Note” in which relevant information is described (e.g., the score 
range of the variable(s), significance). 
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Table 1 
 
Rating of Enjoyment of Different Activities 
 

 
Activity 

 
M 
 

 
SD 

 
 

Attending class 
Sports/working out 
Socializing 
Watching television 
Extracurricular activities 
Volunteer work 
Working (job) 

 
5.32 
5.17 
6.51 
3.63 
5.86 
6.13 
2.56 

 

 
1.59 
1.23 
1.03 
2.54 
2.12 
0.49 
2.10 

Note. All items were rated on a scale from 1 (do not enjoy at all) to 7 (greatly enjoy). 

 

How to Create the Table in Microsoft Word 
 
First, click on the “Insert” tab near the top of the screen and click on the arrow next to “Table”. You can 
then select the number of columns and rows you want in your table. Here I selected 3 columns (one for 
the variable name, one for mean, one for SD) and 2 rows (one for the header row and one for the data 
rows).  
 

    
    
If you are not yet sure how many rows or columns you need, it is easy to add or delete them later by 
clicking within your table, selecting the “Layout” tab, and choosing to insert or delete rows or columns 
(note the left/right, top/bottom options relative to your cursor or current selection).  
 
You will then get the basic table shown below: 
 
   
   

 
 

Obviously, this table is not in APA-style format. In APA style, tables should have only horizontal and 
no vertical lines. To fix the table rules, click on the “Table Design” tab and find the “Borders” option 
near the top right of the screen: 
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Select your entire table and click on the arrow next to where it reads, “Borders”. Choose “none”. Now 
you can go back in and select certain rows of your table and choose a top and bottom border, where 
applicable.  
 
Your table should now look like this: 
 

   
   

 
 

Now you are ready to begin entering your variable names and data into the table. Just place the cursor 
into the table cell and type. Tab to move to the next cell in the table. Below are a few handy tips: 
 

• Use the centering function (under the Layout tab) to center your table headers. Left-align the 
variable names in the left-hand column. Note that you should never try to space anything using 
the space bar (the “eyeball” method). Even if it looks correctly aligned on the screen, it will not 
be correct when you print the table out. 
 

 
 

• Be sure to align your numbers by the decimal point. To do so, first go up to “View” and 
choose “Ruler”. You should now see the ruler at the top of the screen. Select the appropriate 
table columns by highlighting them, and go up to the top left-hand part of the screen, where the 
various tabs are displayed (see below):  

 

 
 
 
 
Note that, for presenting descriptive statistics, tables of means and standard deviations are most 
common, along with tables of frequencies (percentages). In general, psychologists do not produce tables 
of modes (or even medians).  
 
 

Choose the decimal tab by clicking on the tab box until the 
one pictured at the left appears. Now click on the ruler 
where you want the decimal tab to appear (i.e., in the center 
of the column). Doing so for one column will place that tab 
in the same spot in all highlighted columns. Now, when 
you type numbers into the table, they will align 
automatically. If you do need to tab over within a column, 
hold down the “option” key while hitting the tab key. 
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A Second Example: Table of Correlations 
 
It’s often useful to present a table displaying correlations among a set of variables. With only three or four 
variables, you can use variable names in the row and column headers. However, if you have a lot of variables, 
you should number them in the row labels (left-hand column) and then use numbers instead of variable names 
as the column headers, to save space. 
 
As a general rule: 

• Place dashes along the diagonal where each variable is correlated with itself. 
• Place the Pearson r values below the diagonal; leave the cells above the diagonal blank. 
• Use asterisks in the table to designate the significance of your correlations and define them beneath your table 

(see example below).  
• Put the bias-corrected 95% confidence intervals beneath each correlation. You will need to remove the decimal 

tab to center those.  
 
General practice is to include columns with the means and SDs for each variable, as I’ve done below. 
 
Table 2 

Descriptive Statistics and Correlations for Study Variables 

 
Measure 

 

 
1 

 
2 

 
3 

 
4 

 
5 

 
M 

 
SD 

        
1. Stigma 

Consciousness 
 
— 

  
 

 
 

 
 

 
3.37 

 
0.61 

        
2. Self-perceived 

dominance 
-.14 

[-.35, .22] 
 

— 
    

3.06 
 

0.57 
        
3. Self-perceived 

creativity 
-.21 

[-.12, .43] 
.49** 

[.23, .61] 
 
— 

   
3.03 

 
0.68 

        
4. Self-esteem -.33* 

[-.40, -.21] 
.51*** 

[.35, .70] 
.48** 

[.28, .61] 
—   

7.38 
 

1.85 
        

5. Nonverbal 
dominance 

-.02 
[-.19, .10] 

.27* 

[.16, .41] 
.22 

[.14, .39] 
.28* 

[.12, .52] 
 

— 
 

3.21 
 

0.73 
        

 

Note. Stigma consciousness scores ranged from 0 to 6; self-perceived dominance, self-perceived creativity, and 
nonverbal dominance scores ranged from 1-5; and self-esteem scores ranged from 1-11. Bias-corrected 95% 
confidence intervals shown in brackets. 
*p < .05. **p < .01. ***p < .001.  
 
 
 
That should get you started! Remember that you can always Google for help if you run into trouble… 
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APPENDIX B - Psych./Neuro. 201 
Creating Figures in Microsoft Excel (for the Macintosh) 

 
If you decide to use a figure in a paper, you should create it using Excel. NOTE: Neither Google Sheets nor the web version of 
Excel that Hamilton provides allow for custom error bars. If you don’t have Microsoft Office on your computer, you will need 
to use a lab computer somewhere on campus that has Excel on it, so plan ahead. Creating a figure in Excel is very easy. For 
instance, let’s imagine that I wanted to graph the data from the example we used in class for the one-way ANOVA. Recall that the 
three conditions were (1) criminal record, (2) clean record, and (3) no information, and that the DV was a rating from 1 (completely 
sure of defendant’s innocence) to 10 (completely sure of defendant’s guilt). [Note: Example for two IVs is on p. 5.] 
 
In Excel, I would type the mean of each group into a spreadsheet, as shown below: 
 

 
 
Note that I have included the heading for each level of the IV. If I had more than three levels of the IV, I could continue adding rows. I 
could also have presented the information in three columns rather than in three rows; it doesn’t matter. You can always change it once 
you’ve created the graph by double-clicking on the graph and choosing “Switch Row/Column” from the Chart Design toolbar. 
 
Next, highlight all six cells and go up to the “Insert” tab. You’ll get the options shown below. Choose the icon that looks like a column 
bar graph (I’ve circled it below).  
 

 
 
You will then see a variety of column chart types, as shown below. Click on Clustered Column (top left option). 
 

  
 
 

 
 
Select the “Chart Design” tab and then choose “Add Chart Element” (all the way to the left). You will see the following options. 

0

1

2

3

4

5

6

7

8

9

criminal2record clean2record no2information

Chart2Title
In APA-style, we don’t 
include a chart title, so you 
can click on the box that reads 
“Chart Title” and delete it. 
 
We do, however, need to label 
our axes. To do so, click on 
your chart and you will see the 
menu options below. 
 

Your bar graph 
will then appear 
as part of your 
spreadsheet, as 
shown in the 
figure to the 
right.  
 



   

—Page 64— 

 
 
You can play around with the formatting of the figure. For APA-style papers, your bars should be black or grey. To change bar colors, 
simply double click on a bar. You will then see the box below on the left.  
 
 
 
 
 
 
 
     
 
 
 
 
 
 
 
You can also adjust the scale of your y-axis by either double-clicking on it or by choosing the “Axes” option on the toolbar and 
selecting “More Axis Options” (see box below, left). Either way will bring up the “Format Axis” dialog box shown below, right.  
 

  
 
 
 
 
 
 
Other chart features can be changed via the “Add Chart Element” option. If your figure requires a legend (as it does if you have more 
than one IV), you can choose its position (e.g., top, bottom, left, right) here under the “Legend” option. You can also select the 
“Gridlines” option to remove the horizontal gridlines if you wanted to (your choice). 
 
You can also play around with the font sizes. If you click in the upper left-hand corner of the chart, you can select the entire chart, and 
then click on the “Home” tab to change the font and sizes of all text that appears in the chart. As a rule, you should use a sans serif 
font (such as Helvetica or Arial) for figures. I usually use 14-point font for my axis titles (though I’ve squashed some of the figures in 
this handout to make them fit on the page!).  
 

Select “Axis Titles” and then “Primary 
Horizontal.” This will create a text box below 
your figure where you can type in your x-axis 
label (I typed “Experimental Condition”). You 
can then select “Primary Vertical” and type a y-
axis title. I chose “Mean Rating of Defendant’s 
Guilt.” It is very important to label your axes. 
Be sure to capitalize all major words in your 
axis titles. 

Choose the left-most icon 
to change bar colors. 

Then select the 
“Color” option (as 
indicated to the left), 
click on the drop-down 
for “Fill,” select “Solid 
fill,” and then choose 
your preferred bar 
color. 

For this example, the rating scale ranged 
from 1-10, so a y-axis value of 0 is not 
appropriate. To change the scale, change the 
minimum to 1 and the maximum to 10.  
 
In other cases, you might want the minimum 
to be zero. 
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APA style requires that you remove the border around the figure. To do so, double-click on the border to bring up the “Format Chart 
Area” dialog box you used before for changing the bar colors. This time, select the “Border” option and choose “No line” instead of 
“Automatic”. 
 

 
To get the figure into your Microsoft Word document, click on the figure in Excel, select Copy (command-C), choose “Paste Special” 
from the Edit menu in Microsoft Word, and then choose “Paste as pdf.” You can resize the figure by dragging it from a corner (don’t 
drag it from an edge or you will stretch or squeeze it). You might need to double-click on the picture of the figure, select “wrap text” 
from the menu bar, and then select “square” or “in front of text” to get the picture to stay put. 
 
You can then type the figure number and title, as shown below. The words “Figure 1” are in bold and the title, double-spaced beneath 
the figure number, is in italics with upper- and lower-case letters.  
 
Figure 1 
 
Mean Guilt Rating as a Function of Condition 
 

 
 
Adding Error Bars 
 
Often, it is useful to include in your figure error bars that indicate one standard error (standard error, NOT standard deviation) above 
and below the mean for each level of the IV. Doing so gives your viewer a sense of the variability of the data. To create the error bars, 
you simply type the standard errors into the spreadsheet, as I’ve done below for our example (you can find the standard errors on the 
SPSS printout):  
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Click on the figure, go to “Add Chart Element,” select “Error Bars,” and then “More Error Bars Options…” (as shown below): 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
As noted earlier: Neither Google Sheets nor the web version of Excel that Hamilton provides allow for custom error bars. If 
you don’t have Microsoft Office on your computer, you will need to use a lab computer somewhere on campus that has Excel 
on it. 
 
 
The new bar graph appears below. Note that in order to make the error bars stand out, I changed the bar colors to light grey and 
removed the horizontal lines on the graph. As per APA style, you should include a figure note beneath the figure to specify what the 
error bars represent. 
 
 
Figure 1 
 
Mean Guilt Rating as a Function of Condition 
 

 
 

 
 
 
 
 
 
 

 
 
 
 
 

 
Note. Error bars represent one standard error above and below the mean. 
 
 

You’ll get the dialog box shown to the 
right. Choose “Both” under the 
Direction option (this is the default). 
This will give you error bars depicting 
one standard error above and one 
standard error below the mean. Then 
choose “Cap” for the error bar style. 
Under Error Amount, click on the 
button labeled “Custom,” then “Specify 
Value.” You’ll see the dialog box 
below.  
 
 

 
Click in the box next to “Positive Error Value.” In the spreadsheet, highlight the three boxes with 
the standard error values you inputted. They will automatically appear in the white box. This will 
create the line indicating one standard error above the mean. Hit enter. Repeat this process in the 
white box next to “Negative Error Value” (to create the line indicating one standard error below the 
mean), click enter, and then click OK.  
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Creating Figures When There is More Than One IV 
Imagine that I conducted an experiment very similar to the first, only now I was interested in whether an additional factor—
gender of the defendant—also played a role in guilt ratings. My design would now be a 3 (prior information: criminal record, 
clean record, no information) x 2 (gender of defendant: male or female) factorial design. (Assume no defendants reported 
being transgender or non-binary.) I have two independent variables, one with three levels and one with two levels.  
 
Imagine that my new means and standard errors are as follows: 
 

 
 
 
Again, highlight all the cells with means (including the headings) and follow the same instructions as before to create a 
clustered column chart. When you see a preview of your figure, you’ll notice that the different criminal record conditions are 
displayed along the x-axis, and that gender of defendant appears in the legend (one bar for male and one bar for female at 
each level of the other variable). I think this format makes sense for these data, but if you analyzed the data the other way and 
wanted to reverse the placement of these variables (e.g., have gender of defendant along the x-axis and the other variable in 
the legend), you could go to the “Chart Design” toolbar and select “Switch Row/Column.” You do NOT need to re-type 
everything! 
 
For some reason, the current version of Excel makes the male and female bars at each level of the criminal record IV not 
touch each other. To make the bars touch, go to the “Quick Layout” menu and pick the image you like best (with bars 
touching). You may have to make some adjustments to get rid of other features of that layout you don’t want (e.g., the means 
written at the top of the bars or a chart title). 
 

  
 
 
 
 
 
 
 
 
Figure 1 
 
Mean Guilt Rating as a Function of Condition and Gender of 
Defendant 

 
Note. Error bars represent one standard error above and below the mean. 

male female male std. error female std. error
criminal record 9 7.8 0.6 0.4
clean record 4.6 3.1 0.36 0.2
no information 6.7 4.8 0.42 0.3
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Now you can make all the same adjustments as you made 
for the earlier example (e.g., deleting the border, changing 
the font & size, labeling the axes, changing the bar colors, 
changing the scale of the y-axis, adding error bars). Note 
that you’ll need to make two columns of error bars, one for 
male and one for female. When you add the error bars for 
the “male” or “female” bars, make sure you’re selecting the 
correct row of standard errors. 
 
Go to “Add Chart Element” and “Legend” to choose the 
placement of the legend. 
 
Now that you have two bars at each level of the criminal 
record IV, you should create bars of contrasting colors, still 
using shades of grey (to allow for the error bars to show 
up). Below is my completed figure. 
 

Notice that I’ve typed the “male” and “female” headings in the second and third 
columns. I could also have put male and female down the left column and the 
levels of the other variable across the top row; it doesn’t matter. How can I 
represent these data in a bar graph? 
 

That’s it! If you can’t figure something out, 
Google it or use the Excel “Help” menu.  
Have fun! 
 


